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1 Introduction

This document contains specific information and procedures to follow to successfully install the Engage Voice

Recorder software onto one or more servers, including:

l Pre-installation documentation, readiness checks for deployment and setting installation schedules.

l Installation documentation, planning and required tasks.

l Initial system installation, configuration and setup tasks.

l Post-installation configuration, system monitoring and initial customer training.

1.1 Installation Overview

This document contains information and procedures for installing the Engage voice recorder system on one

or more servers in a deployment.

Typical installations proceed in the following phases:

Installation Planning

l Pre-installation planning meetings.

l Statement ofWork (SOW) created after pre-installation meetings and sent out for review.

l Customer approves SOW and SOW discussion meetings, as needed.

l Installation scheduled.

Pre-Installation readiness meeting(5 business days before installation start)

l Review recording and user forms, check server readiness.

l Check PBX and SQL readiness.

l Transfer software onto server.
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l Discuss SOW and any changes, as needed.

l Confirm installation dates.

Installation

l Load and install the product and support software.

l Setup basic recording configuration and start monitoring.

Post Installation Configuration & Monitoring

l Configure system and any add-on capabilities.

l Conduct first level Administrator Training and review of setup.

l Begin monitoring events.

l Conduct second level training (Administrator & Supervisor).

1.2 Installation Pre-Planning Meeting

Once the order is received, the installation scheduling team reaches out to the reseller / customer for key

installation contacts and the pre-installation planning meeting is scheduled.

During the pre-installation planning meetings, all aspects of the installation are discussed.

Dependencies are discussed and expectations are set.

Key information is collected, and this allows the Statement ofWork to be generated.

Forms are also sent out and should be returned with the SOW if possible. If the data is not yet available, it

must be returned by the pre-installation readiness. Should the key recording information not bemade avail-

able by the Pre-installation readiness call, the installation may need to be rescheduled which can add sig-

nificant delay.
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l Server forms containing all defined system and network administrator user accounts, IP addresses, NIC

card assignments and SQL instance names completed and returned.

l Project information forms with project personnel names, email addresses, phone numbers, schedules, loc-

ations and responsibilities are completed and returned.

l Completed pre-installation forms for recording information such as phones, agent names and IDs, the

recording rules for the recording schedule, playback forms for playback access such as user names, user

IDs, user roles, and organizational permissions.

User forms provided before start of installation will be data filled into the product by the installer. Should user

forms not be supplied, the customer will be responsible for configuring user accounts and agents.

1.3 Signed Statement of Work (SOW)

The Statement ofWork (SOW) includes an overview of products purchased, infrastructure required, storage

requirements, dependencies, and a provisioning overview.

The SOW is sent out for review, and the customer approves or requests changes to the SOW.

Once the SOW is returned, the installation is scheduled, and a pre-installation readiness meeting is planned

five (5) business days before start of installation. Additional meetings can be scheduled as needed.

1.4 Installation Forms

The following documents must be filled out and returned to the project manager prior to the Pre-installation

readiness call.

l Server forms: These contain all defined system and network administrator user accounts, IP addresses,

NIC card assignments and SQL instance names completed and returned.

l Pre-installation forms: These are used for recording information such as agent names and IDs, the record-

ing rules for the recording schedule, playback forms for playback access such as user names, user IDs, user

roles, and organizational permissions.
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2 Pre-Installation Tasks and Readiness Meeting

At the beginning of each installation project, TelStrat will provide the customer/reseller with details and

information regarding their pre-installation tasks via meetings, emails and documentation. All tasks must be

completed prior to the start of installation or the schedule could be jeopardized.

The following topics will be discussed during the pre-installation planning meeting. Any topics with an (*) are

to have a corresponding Parature checkbox or field to document.

Pre-Installation Tasks and Checklist
SCOPE OF WORK

☐ Has the Distributor / End User tech read the scope of work?

☐ Do they have questions on the Scope ofWork?

☐ * Is the Scope still valid as to the current customer requirements? Any changes since the SOWwas writ-

ten? Will This require the project to be re evaluated?

☐ Have they filled out and returned Documents?

SERVER & NETWORK

☐ Is the server on the network and joined to the domain?

☐ Is the correct operating system installed per SOW?

☐ Is the system hardware configured as per the SOW (Partitions, Ram, and CPU)?

☐ Identify the TLAN and CLAN IP Addresses?

☐ Firewalls and TCP/UDP ports requirements?

☐ Have you logged in as the account you will be installing under?

☐ Download Latest software of Engage, SOA Services and Web?

☐ Download Prerequisites?
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Pre-Installation Tasks and Checklist

☐ Download SQL Express (if Needed)?

☐ Download extra software features? i.e. Screen Capture, ODRC?

☐ Download any extra Hot fixes?

If Customer is to download:

☐ Have HTTP://ESUPPORT.TELSTRAT.COM downing instructions provided?

PBX CONFIGURATION

☐ Verify they have programmed the PBX according to installation type?

CTI Application Login (Application User Account, AES Account, Etc)

Correct licenses? (DMCC Full, LAN CTE. etc.)

Phone provisioning – (AST, BIB, Etc)

Verify they have downloaded their TSP client, i.e. Avaya, Cisco, ShoreTel

TAP Cards, Splitter and Cabling in place? (If applicable)

TALC Cards and wiring in place? (If applicable)

LICENSING

☐ PROXY Licenses requested? (If applicable)

☐ Soft Dongle License is required after hours

LOGISTICS

☐ Verify Connection method for Remote installation( Webex, VPN, Team Viewer, Etc)

☐ PC and Phone Available for Testing

☐ Verify the Installation Start Times and any After hour start times (verify their time zone)

http://esupport.telstrat.com/
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Pre-Installation Tasks and Checklist

☐ Ensure you have the contact’s phone number to call at the start times

☐ Ensure that the tech will be available by phone when needed

2.1 Pre-Installation Documents Completed

Prior to the deployment, all company related and TelStrat installation forms must be completed and returned

to TelStrat for reveiw. This is an important step to keep the deployment moving smoothly.

2.2 Dedicated Local or Domain Account Created

Engage requires a local user or domain account be created with a password that never expires. 

This domain account must be configured as a local administrator on each Engage server.

The domain account is created for the following requirements:

l If recordings are to be archived on a remote shared storage location such a Storage Area Network (SAN),

Network Attached Storage (NAS), or remote file server.

l If screen capture is to be used.

l If speech analytics is to be used.

l If encryption is to be used.

If the Engage deployment meets any of the above criteria, a domain account with a password that never

expires must be created, and this domain account and password must be available during the Engage soft-

ware installation.  This can be one account.

2.3 Document the SMTP Server Information

The voice recording server is a mission critical business service. It may depend on access to other parts of the

customer network or remote SQL servers.  Engage attempts to issue alerts for detected system issues via

SNMP or Email alerts.  Email alert notification is the preferred choice for most deployments and will only func-

tion if the correct SMTP server information is entered into Engage. 
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It is important for the customer to provide the SMTP Server information to the Engage installation technician

for configuration in Engage. Otherwise, emailed system alerts will not be available, which will result in exten-

ded installation and system down time.

The Engage server must be added as a trusted host on the Email relay server.  Deployments with a ded-

icated web server require that both the Engage Record server and web server be added as a trusted host.

The FROM address found in Critical Event Services emails can be changed to a specific address, if desired.

2.4 Basic Server Preparation and Verification

All Engage servers require the following basic server preparations and verifications:

l Windows Updates Must Be Applied. Prior to the start of installation, the customer must apply Windows

Updates. This can save up to one hour of installation time per server depending on the installed OS type

and release date.

NOTE: TelStrat recommends that customer server software updates bemonitored and supervised and not

set to be performed automatically. Should customers need to perform unattended software updates,

TelStrat recommends testing all server functionality after updating to verify that the updates did not neg-

atively impact the system's ability to record and playback calls, screen captures, encryption key use, etc. Cus-

tomers can request that TelStrat be available during their server updating procedures and arrangements for

technical support can bemade by contacting TelStrat Technical Services Support.

l Add the Engage Domain Account to the Local Administrator's Group. Prior to the start of installation,

the customer must add the Engage Domain Service Account to the local Administrator group on each

Engage server.

l Storage Partitions and Mass Archive Must Be Setup.All storage partitions defined in the Scope ofWork

must be defined. Any Mass Archive locations(s) must be defined and the Engage Domain account must be

granted full permission to this shared location. Refer to the pre-installation scope of work document for

the recommended partitions and sizes required. Windows Server 2008 and newer includes Partition tools

in theDisk Management tool located at Administrative Tools » Computer Management.
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l Static IP Addresses Must Be Assigned. The static IP addresses must be assigned to all Engage Record serv-

ers.

l Anti-Virus Software must be DISABLED During Installation. Any anti-virus softwaremust be disabled on

the Engage servers during installation.

l Power settings Must Be Confirmed: Power settings must be set to enableWake Timers and must be set

to default to OS High Performance under Control Panel » Power Options for all Engage servers and the

SQL server. If power settings are not set to High performance, Engagemay fail to record calls due to Allow

Wake Timers being disabled. These important settings are found here:
o Power Options - Select a Power Plan
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o Power Options - Advanced

2.5 Recording Server Network Interface Cards (NICs)

Refer to the provided statement of work documents which should define the number of Ethernet NIC(s)

required for the recording server. Most deployments require 2 Ethernet NIC(s):

l C-LAN: The Customer LAN (C-LAN), is typically used for Server Administration and Engage Client access.

l T-LAN: The Telephony LAN (T-LAN) interface handles CTI and any RTP packets.

The following deployments require a 3rd Ethernet NIC:

l Port Spanning: Deployments utilizing port spanning require a dedicated NIC for processing spanned RTP

traffic. If port spanning is used, the customer or reseller is responsible for deploying a port spanning cap-

able Ethernet switch and configuring it for port spanning.

l CS 1000 VoIP: Meridian Link Services requires a dedicated Ethernet NIC per PBX requirements.
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Additional Engage products and most VoIP deployments will require additional ports to be opened on the fire-

wall. Refer to the FIREWALL PORT REFERENCE GUIDE and the specific vendor deployment for Engage Voice

Recorder and Engage Feature (Screen Capture, Encryption, Mass Archive, etc) port requirements for addi-

tional firewall configurations.

2.6 PBX License and Configuration Requirements

All PBX implementations will be different in size, connectivity to Engage and tasks required to complete the

the deployment. The following PBX configurations must be completed prior to the Engage installation com-

mencing:

l PBX licenses (if required) need to be purchased, imported and configured according to the customer’s spe-

cific voice system requirements.

l PBX configurations need to be completed for the proposed recording solution defined in the project’s doc-

umentation (ex. Cisco, Avaya, ShoreTel, BroadSoft, etc...).

PBX Licenses: There are a number of software licenses that comewith PBXs. Engage will be looking for specific

ones. The customer must purchase any PBX licenses required for call recording prior to starting the Engage

software installation.

Voice platform licensing requirements, by platform, include:

Voice Platform CTI Software Download

onto Engage

Required Voice Platform Licenses

Avaya ACM Avaya Telephony Server
API (TSAPI)

Avaya TSAPI and DMCC licenses must be purchased from
an Avaya reseller.

Avaya IP Office TAPI2 Service Provider
located from the User
DVD

Avaya CTI Link Pro license must be purchased from an
Avaya reseller.

Avaya CS 1000 None AvayaMeridian Link Services MLS is required for VoIP
phone recording and/or MLS Trunk recording.
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Broadsoft Broad-
works

None Call Recording license, which is user-based, in order to
make use of SIPREC

Cisco UCM Cisco TAPI Service Pro-
vider (TSP)

None

Mitel MiTAI CTI protocol Mitel Recording Licenses

ShoreTel ShoreTel DVS ShoreTel TAPI Application Server license

PBX configurations: Refer to the PBX configuration documentation supplied by the TelStrat project manager

for any steps that must be completed prior to starting the installation.

Some tasks that may be required are:

l A PBX or voice platform system login and password for Engage (Defined in specific voice system doc-

umentation).

l Security access for Engage.

l CTI software downloaded on the Engage Recording Server.

l Configuration of the PBX and designated phones to enable phone device recording.

l Enabling of additional unique PBX features such as Extension Mobility, OnDemand recording, etc…

2.7 Recording Method Hardware (deployment dependent)

Depending on the customer’s recording method, additional hardwaremay be required. Typically analog,

digital and port spanning deployments will require additional hardware in order for Engage to capture or tap

the RTP voice stream.

l Spanning Switches: If using the Port Spanning method in the deployment, a Layer 2 switch with switch

port analyzer (SPAN) capabilities is required. Port Spanning is available in most SIP or digital environments.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

20

l TAP Card: If using analog lines, analog radios, analog DISA Trunks, microphones, T1, E1 or PRI recording

methods, a hardware TAP card will need to be installed.

l TALC Card: If recording Avaya CS 1000 digital phones, the customer must replace the Engage server’s

digital line card with the TelStrat-provided TALC card.

2.8 Testing Telephone and Workstation

For proper testing of a newly installed Engage Voice Recorder system (and its optional features, if installed),

some test telephones and a workstation must be set up and made available. Theminimum needed are:

l At least one working telephone to make test calls to be recorded.

l At least one computer workstation must be available to use with theWeb Client.

l If contact center software is installed, then at least one operational agent ID must be configured. An agent

call must be recorded as part of the customer acceptance testing.

l Microsoft Silverlight version 5.1.30514.0 or newer must be deployed on all workstations using theWeb Cli-

ent unless only basic call playback is required.

2.9 Pre-Installation Planning for Web Client Roles - Recommendations

Each user role defined in the web client Administration » User Roles tab has selections available that enable

or disable features, reports, quality and administration tasks and access for the specific role assigned to the

user. The following are TelStrat's recommendations for the roles definitions which aremade at theWeb Client

User Role tab:
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The recommendations for each role definition is taken from this core set of selections:

Administrator Role

The following are Administrator Role recommendations.
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Local Administrator Role

The following are Local Administrator Role recommendations.

Supervisor Role

The following are Supervisor Role recommendations.
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Unrestricted Supervisor Role

The following areUnrestricted Supervisor Role recommendations.

Agents Role

The following are Agents Role recommendations.
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3 SQL Server Software Installation

Engage requires the installation and configuration of one or more SQL instances.  SQL Server softwaremay be

deployed in one of the following supported configurations:

l A dedicated SQL server added for Engage (large deployments).

l Co-Located SQL server on the Engage Record server (smaller deployments).

l Co-located SQL server on an existing SQL server (smaller deployments).

Customers who want to use existing SQL servers will need to add at least one dedicated SQL instance for

Engage Record and configure the SQL login account to be used by Engage.

Engage requires at least one dedicated SQL instance for the call recording database (cache).  A second SQL

instance is recommended to contain all mass archive databases and the web application database.

Depending on themachine configurations (ex. existing SQL2003 or XP), some additional software may need

to be installed first before installing SQL2008, SQL2012 or SQL2014.

NOTE: Customers should be reminded to set up and use periodic SQL database backups for data loss pro-

tection for all Engage product databases.

3.1 Server 2003, XP and Windows 6 Additional Requirements

NOTE: Windows Server 2012 and Server 2008 R2 do not require this step as long as the Application Server

role is already added in the Server Manager.

Installing these software packages can occur in different steps in the installation process depending on

machine and software configurations.

Note: Microsoft .NET software is installed in this release of Engage software and does not need to bemanu-

ally installed.
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If the current system is equipped with Windows Server 2003 or XP and is being upgraded to SQL 2008, then

these software packages need to be installed at this time:

Install Windows Installer 4.5 and then reboot the server. If unsure, proceed with the installation of SQL 2008

R2 Express and a link will be provided by the setup software. Locate, In the downloaded software folders loc-

ated on the Engage Voice Recorder:

Navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-Reqs » Windows

Installer 4.5 and click on either:

l WindowsServer2003-KB942288-v4-x64.exe for the 64-bit version.

l WindowsServer2003-KB942288-v4-x86 for the 32-bit version.

l WindowsXP-KB942288-v3-x86 for theWindows XP version.

l Windows6.0-KB942288-v2-x64 for theWindows 6 64-bit version.

l Windows6.0-KB942288-v2-x86 for theWindows 6 32-bit version.

Install Microsoft .Net framework on the server.

TheMicrosoft .NET Framework enables multiple Engage applications as well as theWeb Client user interface

to communicate successfully with the Engage recorder. TheWeb Client requires Microsoft .NET 4.0 or later.

To install the .NET Framework on aWindows 7 Professional, 2003 or XP server, install the complimentary copy

ofMicrosoft .NET Framework from the Engage folder:

1. Navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-Reqs .

2. Click on the dotNetFx40_Full_x86_x64 file to install .NET Framework.

3. When the setup wizard has opened, select I have read and accept the license terms checkbox.
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4. Click Install and Finish when installation is complete.

3.2 Add the Application Server Role to SQL Server

The Application Server role provides central management and hosting of high performance distributed busi-

ness applications such as those built with Enterprise Services and .NET Framework 4.5 and is required for

Engage.

If the server platform is going to support both the Application Server AND the Web Server (IIS), both sets

of role settings can be implemented at this time. Use this subsection to administer the Application role and

refer to theWeb Server (IIS) Support settings in the web server installation section of this document to per-

form both roles settings and configurations in one session.

NOTE: This step typically requires a restart upon completion.

Select the Application Server Role:
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1. From the Desktop or Start menu, launch the Server Manager tool.

2. On the left-hand top side, click onManage to get themenu and click on Add Roles and Features com-

mand. The Before you Begin window appears. Click Next.

3. On the Select Installation typewindow, make sure the button for Role-based or feature-based install-

ation is selected, then click Next. 
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4. On the Server Selection window, make sure the correct server name (ex. techpubs2012) is selected, then

click Next.

5. On the Select Server Roles window, scroll down the Roles list, locate and enable the checkbox for Applic-

ation Server.  Click Next.
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NOTE: Another pop-up windowmay appear requiring both .NET Framework and Windows Process Activ-

ation Service to be installed. Click the Add Required Features button to install these additional role services

for the Application Server, then click Next.

Select server features

1. At the Select features window, make sure to click on and select the following features:

l .NET Framework 3.5.1

l TCP Port Sharing

l HTTP Activation

NOTE: The Engage Voice Recorder uses WCF services for internal communications.  HTTP Activation is

required for WCF.

2. Click Next then click Install at the Confirm Installation Selections pane.

3. Click Closewhen the installation has succeeded and Close the Server Manager.

NOTE: If desired, make sure the File and Storage Services role is turned on. When File Services is turned on,

Windows can manage storage and faster file searching.
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3.3 Install SQL 2012 Server Software

The Engage recorder uses SQL databases to collect and sort all of the various voice and call event data packets

for call playback, mass archives, contact center agent information and other data storage.

To install SQL 2012 server using the provided SQL 2012 Express edition, use the downloaded software found

on the Engage server in the folder C://EngageSoftware/MicrosoftSQL.

1. Start the SQL Installation application by clicking on the appropriate executable filename for the deploy-

ment found in this folder. Examples are:
l en_sql_server_2012_express_edition_with_tools_with_sp1_x64.exe for the 64-bit version.

l en_sql_server_2012_express_edition_with_tools_with_sp1_x86.exe for the 32-bit version.

2. Awindowwill ask to let this program make changes to this server. Click Yes.

3. From the SQL Server Installation Center, click on either:
l New SQL Server stand-alone server or add features to an existing installation: To get a fresh,

new SQL 2012 installation (not for a cluster environment).

l Upgrade from SQL Server 2005, SQL Server 2008, SQL Server 2008 R2: To update an existing SQL

to SQL 2012.

4. When prompted for License Terms, check the I accept the license terms check box and click Next.
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5. When prompted with Product Updates, verify that the Include SQL Server product updates check box is

selected, click Next.

6. In the Feature Selection window, LocalDB can be left unchecked and will not affect performance. The

shared feature directory will stay at the default folder of C:\\Program Files\Microsoft SQL Server . Click

Next.
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7. At the Installation Rules window, click Next.

8. At the Instance Configuration window, name the database instance and location of the SQL Call Cache

Database.
a. Rename theNamed Instance to the desired Instance name (ex. ENCACHEX or ENCACHE).

b. Leave the default Instance Root Directory path for the Cache Database unless a different partition

is desired for the SQL database instance. If using a separate SQL server, the Instance root directory

will be the UNC path. The .WAV files location will be configured in the Engage Installer. Click Next.

NOTE: TelStrat installers will use ENCACHEX for SQL Express and ENCACHE for full SQL deployments.
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9. At the Server Configuration window, Service Accounts tab, select NETWORK SERVICE as the SQL Database

Engine.
a. From the Service Accounts tab, locate the table line with SQL Server Database Engine, click the

Account Name cell and click Browse.

b. The Select User, Computer, Service Account or Group windowwill open. Locate the Enter the

object name to select box.

c. Type the word Network in the Enter the object name to select box and click Check Names.

d. Click on Network Service to select it and click OK then click OK again to return to the Server Con-

figuration window.

e. From the Service Accounts tab, locate the table line with SQL Server Browser, click on the Startup

Type cell and click on Automatic.

f. Under the Collation tab, select SQL_Latin1_General_CP1_CI_AS. Typically this is the default set-

ting.

g. Click Next.
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10. At theDatabase Engine Configuration window, Server Configuration tab, click theMixed Mode button.
a. Enter and confirm the password for the Engage service account (sa) login. The password must

meet the domain security requirements. Add any additional SQL administrators at this time.

b. Click Next.

11. Click on theData Directories tab. If using a different partition for the SQL Database Instance, browse for

the directory location. If using a separate SQL server, the Instance root directory will be the UNC path.
a. At the Error Reporting window, click Next.

b. The Send Error Reports check box is optional for the deployment.

12. The Installation process begins. When complete, select Close and then click Close for the SQL Installer.

13. Re-run the install process to create all other instances required for the deployment.

NOTE: Second SQL Instances: It is recommended to install a second SQL instance for the web data-

base / mass archive database for sites larger than 200 recording seats. Engage Record will use one SQL

instance (config and SRecordingCache), and a second SQL instance is for all other applications (web

application database, mass archive, WFM, etc.).

3.4 Install SQL 2005 Backwards Compatibility Software

This package ofMicrosoft software (SQL2005 Backwards Compatibility) is about making existing features come

together with new ones by reducing problems.
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1. To install the SQL 2005 Backwards Compatability software, use the downloaded software found on the

Engage server in the folder C://EngageSoftware/MicrosoftSQL folder. Click on the appropriate link for

the deployment:

l SQLServer2005_BCx64.msi for the 64-bit version.

l SQLServer2005_BCx86.msi for the 32-bit version.

2. When the installer appears, click Next. 

3. Check the checkbox to Accept the terms of the Licensing Agreement. Click Next

4. If desired, enter a name and organization. Click Next.

5. On the Feature Selectionwindow, deselect all choices except SQL Distributed Management Objects

(SQL-DMO). Click Next.
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6. Click Install. When the install has finished. Click Finish and close the installer.

3.5 Configure the SQL Instance for TCP/IP

To configure TCP\IP and Named Pipes on the Engage SQL instance:

For Windows 7, Windows Server 2008 or 2012:

1. Launch to the SQL Server Configuration Manager.

2. From the left pane, click on SQL Server Network Configuration » Protocols for <INSTANCE>, typically

ENCACHEX or ENCACHE.

3. Right click on TCP/IP to select properties. Select Enable. A warning appears, click OK. Restart of the SQL

server instance service is required to apply the new setting.

4. Right click on Named Pipes to select properties. Select Enable. A warning appears, click OK. Restart of the

SQL server instance service is required to apply the new setting.

Restart the SQL Server <instance> Service
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1. Navigate to Start » Administrative Tools » Services.

2. Expand Services (Standard) or (Local).

3. Scroll down and locate SQL Server <instance> (ex. ENCACHEX or ENCACHE).

4. Restart the service by right clicking on the name to get the pop-up menu and selecting Restart.

For Windows XP or Windows Server 2003:

1. Open Start » Control Panel » Administrative Tools » Services.

2. Scroll down to SQL Server <instance>.

3. Restart the service by right clicking on the name to get the pop-up menu and clicking on Restart.

After a new SQL install, if the SQL database cannot connect from a different PC, check these items:

l From the Services window, verify SQL Server Browser is in Automaticmode and is Started.

l Verify that TCP/IP is enabled in the SQL Server Configuration Manager. This program is located at Start »

Programs » MS SQL Server » Configuration Tools » SQL Server Configuration Manager. The TCP/IP

parameter must be enabled under SQL Server Network Configuration » Protocols for <instance name>

such as ENCACHEX or ENCACHE.
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NOTE:  Thememory of the Engage SQL Instancemust be limited if any other Engage components are on the

same SQL server to ensure Engage has access to available memory.  Refer to the POST-INSTALLATION

CONFIGURATIONS section of this document which is done after any Engage databases are installed so all SQL

configuration can be done at one time.

3.6 Create SQL Login Accounts

SQL requires a SysAdmin account for each SQL application within the deployment. The account will interact

with:

l Engage Server: Connects the Cache instance to Engage.

l Web Client: Connects theWeb application database to Engage.

l Remote SQL Server: Connects a Remote SQL Server or cluster to Engage.

l Mass Archive: Connects Engage to the storage location.

If the customer is hosting all databases on one server or using a dedicated SQL server for all instances, then a

single SysAdmin account for Engage is sufficient.

If the customer is hosting several different SQL applications on separate servers, then each application of SQL

will need its own access through a SysAdmin SQL Account.

To create a SysAdmin account in SQL:

1. Open Start » Programs » Microsoft SQL » SQL Server Management Studio.

2. Login either using SQL Authentication with the sa login and password setup previously in the SQL install or

login using Windows Authentication with the account presently logged into the server. The login window is

CASE SENSITIVE.

3. From the Object Explorer, expand <Server\Instance Name> » Security
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4. Right Click on Logins and select New Login…

5. Create a new <sysadmin> login for Engage to communicate with the SQL database.
l Enter a Login Name.

l Select SQL Server authentication.

l Uncheck User must change password at next login.

l In the Select a page bar on the left, select Server Roles.

l Check the box for sysadmin.

l Click OK.
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WARNING: If this SQL login or password for the Engage Server is ever changed, Engage will no longer record

calls. TelStrat highly recommends that this login and password be provided to our Support group in order to

provide faster service and a source for lost passwords.

3.7 Verify SQL Management Studio Connection

After installing the SQL database software and instances, verify that the SQLManagement Studio can connect

with the Engage Recorder. This connection must exist to continue the installation.

1. Launch the SQL Server xxxx Management Studio, select the database instance (ex. ENCACHEX or

ENCACHE) of the Engage Recorder and log in.

2. Expand (+) theDatabases tab of the instance. Look for various databases to be established in the list of

Databases.
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3. Expand (+) the SQL Server Logs tab and check for connectivity status.
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4. Double-click on the Current log file to open it and examine the entries. They should show current date and

time and status.

5. Exit the SQL Server xxxx Management Studiowhen done.
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4 Web Server Software Installation

NOTE: SQL 2008 or SQL 2012must be installed and online before installing the web server software.

Both the Web Server role AND the Application Server role are REQUIRED by the Engage Recorder. If theWeb

Server and the Application server will reside on the same server, then both roles can be installed at this time.

This section provides the procedures to install the Engage web server software and some Engage services that

reside on the web server.  These services include:

l TelStrat Engage Search Service.

l TelStrat Engage Dashboard Service.

l TelStrat Engage Quality Dashboard Service.

4.1 Add Engage Service Account to Local Administrators Group

Be sure that the Engage Service Account has been added to the local Administrators Group on each Engage

server in the deployment.

This is to make sure there will be no operating deficiencies or issues with regards to the Engage services.
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4 Digital Certificates

TelStrat customers and their companies are responsible for the procurement, management and deployment

of their business related SSL certificates. Each company will have its own web browsing security plan to follow.

Engage servers and web clients will operate using either an unsecured HTTP protocol or an HTTPS protocol

using using a self-signed or entity-signed certificate.

This capability is programmed during the Engage Services and Web Client installation process.

What is a Self-Signed Certificate

A self-signed certificate is created and configured on the host server and contains just a friendly name and

provides a digital certificate for use in testing or for narrow business use, such as that connection between an

Engage server and an Engage web client. It does not require a third party for signing.

What is a Signed Certificate

A signed certificate is created and configured using the host server and a third party signing source. A signed

certificate contains much more information about the owner of the certificate such e-mail addresses, owner's

name, registered business name, certificate usage, duration of validity and resource location which includes

the Common Name and the certificate ID of the person or entity who certifies or signs this information. A third

party will "validate or certify" the certificate and its content acting as a signing Certification Authority (CA).

Some companies require this.

What are Signing Certification Authorities

A Certification Authority (CA) is an business/entity that generates and issues signed digital certificates. Com-

panies submit Certificate Signing Requests (CSRs) to these agencies which, after some processing, provide

that customer with a signed digital certificate.

There are numerous certifying authorities available including Verisign, Thawt, Godaddy, RapidSSL or StartSLL.

Usually the user's browser or application is already loaded with the root certificate of some of these well

known Certification Authorities (CA) or root CA Certificates. The CAmaintains a list of all signed certificates as

well as a list of revoked certificates. CAs are usually preloaded on all web browsers and provide the assurance

that the user's certificate is signed by a CA that is known by the browser. Only if this happens do you get the

green lock icon in the browser.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

46

How to View Trusted CAs Already Loaded in the Engage Server

Users can view the list of CAs loaded into the OS with the server's CertificateManager. To do this:

1. Logon to the Engage server and launch the Startmenu and click on the Control Panel.

2. Click on Control Panel » All Control Panel Items » Credential Manager.

3. Click onWindows Credentials to expand the window.

4. Click on Add a certificate-based credential to open the Add a Certificate-Based Credential window.

5. Click on Open the Certificate Manager to get the certmgr Certificated Current Userwindow.
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6. Click on Trusted Root Certification Authorities and expand Certificates to see the list of trusted cer-

tificates.

7. When completed, this process will allow users to see a trusted certificate for an Engage URL if it were a

good certificate signed back to a CA.

Create a Self-Signed Certificate for the Server

Engage can be configured to use a self-signed certificate to secure the connection between the server and web

clients. The certificate can be generated and configured without having to go to a third party source for a

digital certificate.
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1. Launch the Engage server's Server Manager,

2. Click on the Toolsmenu and click on Internet Information Services (IIS) Manager to get the IIS Manager

window.

3. Highlight the server's name (ex. TECHPUB2012) to get the server's Home page. Double-click on the Server

Certificates icon to get the Server Certificates window.

4. On the right-hand pane, click on Create Self-Signed Certificate and get the Create Self-Signed Certificate

window.
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5. Complete the Create Self-Signed Certificate entries as follows:
a. Specify a friendly name for the certificate: Enter a name that the certificate will be issued as (ex.

SandboxCert).

b. Select a certificate store for the new certificate: Select Personal. Click OK.
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6. The screen will close to the Server Certificates window. The new certificate with a name (ex. SandboxCert)

will be displayed.

Set the HTTPS Site Binding

1. On the left-hand pane, highlight Default Web Site to get theDefault Web Site Homewindow. On the

right-hand pane of the Homewindow, click on Bindings.... In the Site Bindingwindow, click Add.

2. Enter the following binding elements:
l Type: Use the drop-down menu to select https.

l IP Address: Leave at default ofAll Unassigned.

l Port: Leave at HTTPS default port of 443.

l Hostname: Enter your host name (ex. techpub2012.corp.telstrat.com).

l Require Server Name Indication checkbox: Leave unchecked.
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l SSL Certificate: Use the dropdown menu to select the self-signed certificate name (ex.

SandboxCert).

l If needed, click View to see details of the certificate. Otherwise, click OK.

l Note the new binding has been added. Click Close.

Be sure to test the browser's access to the EngageWeb Client AFTER the web client software is installed.

4.2 Add and Configure Web Server (IIS) and Application Server Roles - Required
Web Server (IIS)

TheWeb Server (IIS) role is required and must be added and configured on the web server. Select the appro-

priate operating system that theWeb Server will be installed on and follow the steps.

With Web Server IIS, Microsoft includes a set of programs for building and administering Web sites, a search

engine, and support for writing Web-based applications that access databases, such as the EngageWeb Cli-

ent.

Application Server

The Application Server role is required for Engage to operate and function properly.

The Application Server provides the central management and hosting of high performance distributed busi-

ness applications such as .NET Framework 4.5, TCP Port sharing and theWindows Process Activation Service

Support which provides HTTP activation, TCP activation and Named Pip Activation.
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If theWeb Server (IIS) and the Application Server are going to reside on the same server platform, then both

of these roles can be added and installed during one installation session.

4.2.1 For Windows Server 2012

There are two ways to setup the Application Server and theWeb Server (IIS):

l Using a TelStrat, Inc. provided XML file that will import the changes to the settings.

l Manually configuring the changes to the settings.

Import Windows Server 2012 Application Server and Web Server (IIS) Roles and Features Changes

This XML file can be used to make the needed Roles and Features changes on Application Server and theWeb

Serv er (IIS). The procedure is:

1. Go HTTP.//SUPPORT.TELSTRAT.COM , and login in to download the XML file software, if not already done.

2. Copy the EngageUnityRoles_2012.xml file from the Engage 02-CUSTOMER PRE-REQS/Engage x.x Pre-

Reqs & Tools/Windows Roles XML/ folder to the server's C:\EngageSoftware folder.

3. OpenWindows PowerShell as an administrator and run the following command:
l Install-WindowsFeature –ConfigurationFilePath c:\engageSoftware\EngageUnityRoles_

2012.xml

l Windows PowerShell should show “Start Installation…..” with progress to 100%

4. Close the PowerShell program and skip the remaining manual steps.

Note that this XML file can also be used to repair the server role and features, if the necessary. For roles that

are already selected, the power shell will indicate no changes needed, as shown here:

Manually Add Windows Server 2012 Application Server and Web Server (IIS) Roles and Features Changes

http://support.telstrat.com/
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If needed, the Application Server and Web Server (IIS) Roles and Features can bemanually configured. The

procedure is:

1. Launch the Server Manager tool from the desktop icon or from the Start menu.

2. On the Server Managerwindow, clickManage to get themenu and then click Add Roles and Features.

3. Before you Begin

Click Next to go past the Before you Begin window.

4. Installation Type

At the Select installation typewindow, click Role based or feature based installation.
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5. Server Selection

On the Select destination serverwindow, click Select a server from the server pool, click on the

Engage server and click Next.

6. Server Roles

On the Select server roles window:

a. Select the Application Server check box.

b. Scroll down and select theWeb Server (IIS) check box.

c. Click Next to continue the install.
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7. Features

On the Select Features window, select:

a. .NET Framework 3.5

b. .NET Framework 4.5

c. Scroll down and selectWindows Process Activation Service

d. Click Next.
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8. Application Server

On the Select Role services for the Application Serverwindow, select:
a. .NET Framework 4.5

b. TCP Port Sharing

c. HTTP Activation

d. Click Next.

9. Web Server Role (IIS)

In the Select role services window:
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a. Under Common HTTP Features, select:
1. Default Document

2. Directory Browsing

3. HTTP Errors

4. Static Content

5. HTTP Redirection

b. Under Health and Diagnostics, select:
1. HTTP Logging

2. Request Monitor

3. Tracing

c. Under Security, select:
1. Request Filtering

2. Windows Authentication

d. Expand Application Development and select:
1. .NET Extensibility 3.5

2. .NET Extensibility 4.5

3. ASP.NET 3.5

4. ASP.NET 4.5

5. CGI

6. ISAPI Extensions

7. ISAPI Filters
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e. UnderManagement Tools, select:
1. IIS Management Console

2. IIS Management Capability

3. IIS Management Scripts and Tools

4. Management Service

f. Expand IIS 6Management Capability and select:
1. IIS 6Metabase Compatibility

2. IIS 6Management Console

3. IIS 6 Scripting Tools

4. IIS 6WMI Compatibility

10. Verify the following selections aremade and then click Next to continue to the Confirmation window:
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11. Confirmation
l At the Confirmation window, select Install to install the updated settings

12. Click Close when the installation has succeeded and close the Server Manager.

4.2.2 For Windows Server 2008

The procedure to add and configure theWeb Server 2008 (IIS) role is:

1. Open Start » Administrative Tools » Server Manager and launch theWizard.

2. Check if theWeb IIS Server has been installed by clicking on Roles in the left pane, expanding it or Server

Manager » Roles.
a. For a new server, click Add Roles in the right pane to install Web Server (IIS).

b. IfWeb Server (IIS) is already installed, then right click onWeb Server (IIS) in the left pane and click

Add Roles to verify the entire role services listed in this document are already selected.

3. From the Add Roles Wizard window, select Next.  Click Next on the Before You Begin window.  The Select

Server Roles window appears.
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4. Select the checkbox for Application Server.

5. Another pop-up windowwill appear requiring both .NET Framework andWindows Process Activation

Service be installed. Select Add Required Features to install these additional role services for the Applic-

ation Server.

6. Select the checkbox forWeb Server IIS. Click Next.  At the Introduction to Application Serverwindow,

select Next.

7. At the Application Server Select Role Services window, enable the following services:
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a. Select .NET Framework 3.5.1

b. SelectWeb Server (IIS) Support

8. A pop-up windowwill appear noting additional Application Server, Web Server (IIS) and .NET Framework

services. Select Add Required Role Services.

a. Select TCP Port Sharing

b. Select HTTP Activation

c. Select Next.  At the Introduction to Web Server (IIS)window, select Next.

9. On the Select role services window, required services will be selected when Web Server (IIS) Support

Required Role Services are installed.  Select ALL additional services in BOLD:

l Under Common HTTP Features, verify that Static Content, Default Document, Directory Browsing,

HTTP Errors and HTTP Redirection are selected.
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l Under Application Development, verify that ASP.NET, .NET Extensibility, CGI, ISAPI Extensions, and

ISAPI Filters are selected. Under Health and Diagnostics, verify that HTTP Logging, Request Mon-

itor, and Tracing are selected.

l Under Security, verify thatWindows Authentication and Request Filtering are selected.

l UnderManagement Tools, verify that IIS Management Console, IIS Management Scripts and

Tools, andManagement Service are selected.

10. Select IIS6 Management Compatibility, then IIS 6 Metabase Compatibility, IIS 6 WMI Compatibility,

and IIS6 Scripting Tools check boxes.

11. Select Next, then click Install at the Confirm Installation Selections pane.

12. Select Closewhen the installation is completed and click Close on the Server Manager.
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NOTE: File Services can also be turned on so that Windows can manage storage and faster file searching. If

desired, make sure the File Server role is turned on.

4.2.3 For Windows 7

The procedure to add theWeb Server (IIS) role on Windows 7 ProfessionalWorkstation is:

1. Click Start » Control Panel » Programs » Programs & Features. In the left menu, click Turn Windows

Features on and off.

2. Under Internet Information Services » Web Management Tools » IIS 6 Management Compatibility ,

check the following roles: IIS 6 Scripting Tools, IIS 6 WMI Compatibility, IIS Metabase and IIS 6 con-

figuration compatibility, IIS Management Console, IIS Management Scripts and Tools and IIS Man-

agement Service checkboxes.

3. Under Internet Information Services » World Wide Web Services » Application Development Features,

check the following roles: .NET Extensibility, ASP.NET, CGI, ISAPI Extensions and ISAPI Filters check-

boxes.

4. UnderWorld Wide Web Services » Common HTTP Features, check the following roles Default

Document, HTTP Errors, HTTP Redirection and Static Content checkboxes.

5. UnderWorld Wide Web Services » Health and Diagnostics, check the following roles HTTP Logging,

Request Monitor, Tracing checkboxes.

6. Under Security, check the following roles Request Filtering andWindows Authentication checkboxes.

7. Click OK. Windows 7will take a fewminutes to make the changes to the Features settings and show pro-

gress with a window.
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8. When completed, reboot theWindows 7machine.

4.3 Install Engage Services, HTTPS (if used) and the Web Client

With the server OS and SQL software installed and configured, the following can be installed:

l TelStrat Engage Services.

l EngageWeb Client and its database.
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l HTTPS, is used.

l Another web database for backup and upgrade purposes.

NOTE: If the customer requires a secure HTTPS URL for the server-web client connections, a digital

SSL certificate namewill need to be available for this installation. Refer to HTTPS Certificates for details.

Engage software installation is normally accomplished by launching a setup.exe type file which will step

through the installation of the various services, HTTPS and web client installations.

Begin the Engage Services and Web Client software installation (locally or remotely):

NOTE: If the setup program encounters a problem, click OK to end the installation process and refer to the

Troubleshooting section of this guide, specifically, Web Server Troubleshooting topics for help.

To install the Engage Services and Web Client software, use the downloaded software found on the Engage

server in the folder C://EngageSoftware/Engage5.x.x.

1. Navigate to Engage 5.x.x. » Engage 5.x.x.x Web.zip folder, unzip it and execute the TelStrat.exe file to

begin to installation procedure. TheWelcomewindow appears. Click Install.

2. There will be a series of setup progress screens that will pop up as the wizard installs various software ser-

vices and components.
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3. At the End-User Licensewindow, click on I accept the terms of the License Agreement and click Next.

Install the TelStrat Engage Search Service

1. When the TelStrat Engage Search Servicewindow appears, click Next.

2. Use the default installation folder for the Search Service (ex. C:\Program Files (x86)\TelStrat\TelStrat

Engage Search Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close.

Install the TelStrat Engage Recording Dashboard Service
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1. When the TelStrat Engage Recording Dashboard Servicewindow appears, click Next.

2. Use the default installation folder for theDashboard Service (ex. C:\Program Files (x86)\TelStrat\TelStrat

Engage Dashboard Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close.

Install the TelStrat Engage Quality Dashboard Service

1. When the TelStrat Engage Quality Dashboard Servicewindow appears, click Next.
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2. Click Next. Use the default installation folder for theQuality Dashboard Service (ex. C:\Program Files (x86)

\TelStrat\TelStrat Engage Quality Dashboard Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close

Install the TelStrat Engage Application Configuration Service

Besides installing this service, this part of the software installation will create a newweb database and name in

SQL for theWeb Client to use (ex. Engage).

NOTE: When installing a new Release 5.x or are upgrading from Release 4.x or earlier to Release 5.x for the

first time, ALWAYS install another newweb database to be used by the Import Data web client program to

import data from an existing release 4.x or 5.x database. This procedure preserves the content of this release

of web server's database structure to allow for import of the previous release's configurations and structure.

1. When the TelStrat Engage Application Configuration Servicewindow appears, click Next.

2. Check I accept the terms of the licensing agreement.  Click Next.

3. In the SQL Server Information window, complete these fields with:
l SQL server\instance: The server and instance names for the cache database (ex. tech-

pub2012\ENCACHEX).
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l Authentication: Click the SQL Server Authentication button and enter the Login (sa) and Password.

l Database: Click on Create New database that theWeb Client will use. TelStrat installers use the

default nameEngage for this field.

NOTE: If upgrading from a previous major release, do not connect to an existing database. Create

a new database and then complete the upgrade which includes steps for importing data from a pre-

vious major release. If upgrading from the samemajor release, an existing databasemay be used.

4. Click the Test Connection button to make sure the SQL Cache Database is accessible. Look for the Test Con-

nection Succeeded box. Click OK. Click Install.
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5. After the installation is complete, click Finish.

NOTE: At the end of this installation procedure, there is an additional step (Create an Empty 5.0 Database)

to RERUN theWeb installer to create the new empty database with a different name (ex. Engage51).

Install the TelStrat Recurring Report Service

1. When the TelStrat Engage Recurring Report window appears, click Next.

2. Click Next. Use the default installation folder for theQuality Dashboard Service (ex. C:\Program Files

(x86)\TelStrat\TelStrat Engage Recurring Report Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close.

Install the TelStrat Engage Web Service

1. When the TelStrat EngageWeb Service window appears, click Next.

2. Click Next. Use the default installation folder for theQuality Dashboard Service (ex. C:\Program Files

(x86)\TelStrat\TelStrat Engage Web Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close.

Install the TelStrat Engage Speech Analytics Dashboard Service

1. When the TelStrat Engage Speech Analytics Dashboard Service window appears, click Next.

2. Click Next. Use the default installation folder for theQuality Dashboard Service (ex. C:\Program Files

(x86)\TelStrat\TelStrat Engage Speech Analytics Dashboard Service\).

3. Click Next.

4. Confirm the installation by clicking Next. When the installation is complete, click Close.

A number of pop-up windows will flash by as the setup and installation process continues.

Install the TelStrat Engage Web Client
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1. When the TelStrat Engage Web Client Setupwindow appears, click Next.

2. Click on I accept the terms of the License Agreement and click Next.

3. At the Select Instancewindow, click on Add Instance.

4. At the Select Instance Address window, enter Engage into the Virtual Directory field and click Next.
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5. At theHTTPS Configurationwindow,
l If the customer configuration does not requireHTTPS URL security and no SSL certificate is avail-

able, click Next to bypass this window.

l If the customer configuration does require a secure HTTPS web URL, check the Enable HTTPS check-

box and select the appropriate SSL certificate from the drop-down menu, then click Next.

6. Confirm the installation by clicking Next.

7. Start the installation by clicking Install. A number of installation screens and pop-ups occur.

8. When the installation is complete, click Finish.
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There will be a fewmore update screens while the setup process continues. When installation is complete,

Setup Successful will display. Click Close.

4.4 Configure Folder Permissions

After the Services and Web Client software is installed on the IIS web server, folder permissions must be con-

figured or playing back of calls will result in File not Found error messages.  

After making this change, a logoff and logon to theWeb Client is required or anInternal Server Errormessage

will appear.

NOTE: Required for ALL deployment types. 

To provide IIS full permissions for attachments on the web server, make these changes:

1. On the Engage voice recorder server, navigate to c:\inetpub\wwwroot.

2. Highlight the folderwwwroot, right-click on it to get the pop-up menu and click on Properties.
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3. De-select the Read Only check box.

4. Click Apply. 

5. Select the Apply changes to this folder, subfolders and files button. There will be a few update windows.

Click OK.

6. Click the Security tab.
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7. Click Edit then click Add. The Select Users, Computers, Service Accounts, or Groups window appears.

8. Enter Authenticated Users or the appropriate group of users if the customer's IT person is available.

9. Click Check Names button. Authenticated Users should become underlined.

10. Click OK.

11. While highlighting Authenticated Users, click on all Permissions checkboxes, click Apply then OK.

12. If prompted by a newwindow, select Apply Changes to this folder, subfolders and files to complete the

process.

4.5 Rewrite HTTP to Redirect to HTTPS

If the customer's configuration requires the use of HTTPS secure URLs, it will necessary to REDIRECT all

HTTP://<servername>/Engage requests to theHTTPS://<servername>/Engage URL.

To have the server redirect an HTTP:// type URL request redirected to an HTTPS:// type URL, the server's

IIS needs to be prepared.
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Note: If using IIS 8, the user will need to install the URL Rewrite module. If already installed, skip to Create

Rewrite URL Rule subsection.

Install URL Rewrite Software Module

1. Logon to the Engage server as an administrator.

2. From the Server Manager, launch the Internet Information Services (IIS) Manager.

3.

a. If not already installed, a request will bemade to install theWeb Platform Components installer

into the IIS Manager. Click Yes.

b. If installation is needed, the user is directed to a Microsoft website. Click Free Download to start

installation of the freeMicrosoft Web Platform Install tool.
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c. Click Add.

4. When completed, theWeb Platform Installer icon will be available on the in the IIS Manager of the

<servername> server (ex. techpub2012).

5. Click on theWeb Platform Installer icon to generate the list of software that could be added to the server.

Click on the Products heading then click on Name to get an alphabetical list.
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6. Scroll down the list and locateURL Rewrite x.x and click the Add button.

7. Click on I Accept for the license.

8. Click on Install to begin the installation of theURL Rewrite x.x software into the IIS Manager.

9. Click Finish to close the install when completed.
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Create a Rewrite URL Rule

1. Return to the server's IIS Manager page and expand <servername> and click on the newly installed

URL Rewrite icon. If the icon is not present after the install, exit and re-enter the IIS Manager to get the

content of the tool refreshed.

2. Expand the folders for <servername> » Sites » Default Web Site and highlight the Engage folder.

3. Double-click on theURL Rewrite icon to get theURL Rewrite page.

4. On the right-hand Action pane, click on Add Rule to get the Add Rulewindow.
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5. Click on Blank Rule and click OK to get the Edit Inbound Rule screen and enter the following:
a. Name: Enter a descriptive name, such as HTTP to HTTPS.

a. Match URL box:
l Requested URL: Leave the default ofMatches the Pattern.

l Using: Leave the default of Regular Expressions.

l Pattern: Enter (.*) (open round bracket, dot, star, close round bracket).

l Ignore case checkbox: Remains checked.

a. Conditions: Click on the down arrow to get the Conditions box.
l Click Add.

l Condition input: Enter {HTTPS} (open curly bracket, H T T P S closed curly bracket).

l Check if input string: Leave at default ofMatches the Pattern.

l Pattern: Enter ^OFF$ (caret, O F F, $).

l Click OK.
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a. Action: Click on the down arrow to be the Action box.
l Action Type: Click on the drop-down menu and select Redirect.

l Redirect URL: Enter https://{HTTPS_HOST}/{R:1} using open and closed curly brackets.

l Append query timing checkbox: Remains checked.

l Redirect type: Select See Other (303) from the drop-down menu.

6. Click on Apply in the upper right hand Actions pane.

7. Check that the rules were applied successfully by finding the statement that the rules were applied suc-

cessfully.
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8. In the right-hand Actions pane, click on Back to Rule and check the entry.

9. Click the + symbol to expand for a fewmore details.

Check that Redirect Occurs

l Check that the REDIRECT from and HTTP:// URL to an HTTPS:// URL works by using the Default Web Site

window.

l On the right-hand pane, click on the Browse ... .com on *:80 (http) command.

l Observe the browser that launches and make sure the https:// version of the URL appears in the browser

indicating the redirect functioned correctly.
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4.6 Verify Web Client HTTP and HTTPS Screen

It is very important that theWeb Client can be accessed by workstations in the deployment. Depending on

the type of deployment relative to non-secure and secure URLs, access testing will be different.

HTTP Only

If the deployment is using HTTP non-secure URLs to access theWeb Client, check workstations access to theWeb

Client using HTTP. From a workstation, launch a browser and access theWeb Client using an HTTP URL with the

syntax: http://<servername>/engage

(ex. http://techpub2012.corp.telstrat.com/engage/).

Verify the Logon Screen appears with HTTP in the address box.

HTTPS Only

If the deployment is using HTTPS secure URLs to access theWeb Client, check workstations access to theWeb Cli-

ent using HTTPS. From a workstation, launch a browser and access theWeb Client using an HTTPS URL with the

syntax: https//<servername>/engage.

(ex. https//techpub2012.corp.telstrat.com/engage/).

Verify the Logon Screen appears with HTTPS in the address box.
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HTTP Redirected to HTTPS

Additionally, because a deployment is using HTTPS secure URLs, a test is needed to make sure that an HTTP

non-secure URL is rewritten to point to the HTTPS secure URL.

Check this ability from a workstation by launching a browser and entering an HTTP URL with the syntax:

http://<servername>/engage.

(ex. http://techpub2012.corp.telstrat.com/engage/)

Verify the Logon Screen appears with HTTPS and not HTTP in the address box.

Refer to theWEB SERVER (IIS) section of this guide if this screen does not appear.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

85

5 Engage Record Server Installation

Installation and configuring the Engage Voice Recorder software consists of:

l Making sure all appropriate prerequisite software is installed and settings aremade.

l Downloading and installing the Engage product software.

l Downloading and installing support software and tools.

l Configuring the server and restarting services.

5.1 Engage Server Prerequisite Setup

Prior to beginning the Engage software installation processes, some preparation and prerequisite software

must already be in place. Prerequisite requirements are:

l Partition configuration and Domain Account Setup.

l Enabling the Desktop Experience feature.

l Adding the Application Server Role.

l Installing JAVA JRE.

Some Engage software-dependent components will be installed as part of the recorder software installation

process and are do not need to be individually installed, as in previous releases of Engage. These components

include:

l Installing .NET software.

l Installing Microsoft Visual C++ 2008 and 2010.

l Installing theWinPCap for VoIP.

l Installing WinPCap (for a Cisco deployment Only).

5.1.1 Partition Configuration and Adding the Domain Account

All storage partitions must be setup and in place before installing the Engage software on the voice recording

server. Refer to the customer's SOW, project requirements and system specifications for the details for this
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specific deployment.

The Engage Domain Service Account must be added to the local Administrator group on each Engage server

to ensure no operating deficiencies or issues with regards to the Engage services.

5.1.2 Enable the Desktop Experience feature

TheDesktop Experience feature allows installation of a variety of applications and features that are

provided in theWindows client operating system on a server that is running aWindows Server operating

system.

ForWindows Server 2012, theDesktop Experience featuremust be enabled to support playing call record-

ings on the recording server for testing purposes. InstallDesktop Experience using the Server 2012 Server

Manager wizard with these steps:

1. Launch the Server Manager. 

2. On the toolbar, clickManage then Add Roles and Features. 

3. Click Next, then Next again.  Select the server by highlighting it, click Next.

4. Click Features and scroll down and find User Interfaces and Infrastructure.

5. Select theDesktop Experience check box, and click Next.

6. Complete the wizard by clicking Install.

7. A Restartwill be required to add the feature to the server.
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ForWindows Server 2008 R2, theDesktop Experience featuremust be enabled to support playing call record-

ings on the recording server for testing purposes as well. Install the Desktop Experience feature using theWin-

dows Server 2008 R2 Server Manager wizard.

1. Launch the Server Manager. 

2. On the left hand pane, click Features.

3. On the right-hand side, look for and click Add Features. The Select Features window appears.

4. Scroll down the list and find Desktop Experience and check the checkbox.

5. An Add Features Wizard box will appear demanding confirmation for adding the feature. Click Add Reques-

ted Feature.

6. Click Next and complete the wizard by clicking Install.

7. Click Close to terminate the Install Wizard.

8. A reminder will appear that a Restartwill be required to add the feature.

5.2 Add the Application Server Role to SQL Server

The Application Server role provides central management and hosting of high performance distributed busi-

ness applications such as those built with Enterprise Services and .NET Framework 4.5 and is required for

Engage.

If the server platform is going to support both the Application Server AND the Web Server (IIS), both sets

of role settings can be implemented at this time. Use this subsection to administer the Application role and
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refer to theWeb Server (IIS) Support settings in the web server installation section of this document to per-

form both roles settings and configurations in one session.

NOTE: This step typically requires a restart upon completion.

Select the Application Server Role:

1. From the Desktop or Start menu, launch the Server Manager tool.

2. On the left-hand top side, click onManage to get themenu and click on Add Roles and Features com-

mand. The Before you Begin window appears. Click Next.

3. On the Select Installation typewindow, make sure the button for Role-based or feature-based install-

ation is selected, then click Next. 
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4. On the Server Selection window, make sure the correct server name (ex. techpubs2012) is selected, then

click Next.

5. On the Select Server Roles window, scroll down the Roles list, locate and enable the checkbox for Applic-

ation Server.  Click Next.
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NOTE: Another pop-up windowmay appear requiring both .NET Framework and Windows Process Activ-

ation Service to be installed. Click the Add Required Features button to install these additional role services

for the Application Server, then click Next.

Select server features

1. At the Select features window, make sure to click on and select the following features:

l .NET Framework 3.5.1

l TCP Port Sharing

l HTTP Activation

NOTE: The Engage Voice Recorder uses WCF services for internal communications.  HTTP Activation is

required for WCF.

2. Click Next then click Install at the Confirm Installation Selections pane.

3. Click Closewhen the installation has succeeded and Close the Server Manager.

NOTE: If desired, make sure the File and Storage Services role is turned on. When File Services is turned on,

Windows can manage storage and faster file searching.
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5.2.1 Windows Server 2003 and XP Additional Requirements

Installing these software packages can occur at different steps in the installation depending on machine con-

figurations. However, they must be installed for Engage to function properly.

NOTE: If the current system is equipped with Windows Server 2003 and XP and is being upgraded to SQL

2008, then these software packages need to be installed.

Install Windows Installer 4.5 and then reboot the server. If unsure, proceed with the installation of SQL 2008

R2 Express and a link will be provided by the setup software. Locate, In the downloaded software folders loc-

ated on the Engage Voice Recorder:

Navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Installer 4.5 and click on

either:

l WindowsServer2003-KB942288-v4-x64.exe for the 64-bit version.

l WindowsServer2003-KB942288-v4-x86 for the 32-bit version.

l WindowsXP-KB942288-v3-x86 for theWindows XP version.

l Windows6.0-KB942288-v2-x64 for theWindows 6 64-bit version.

l Windows6.0-KB942288-v2-x86 for theWindows 6 32-bit version.

NOTE: Windows Server 2012 and 2008 R2 do not require the following step as long as the Application Server

role is already added in the Server Manager.

Install Microsoft .Net framework

TheMicrosoft .NET Framework enables multiple Engage applications as well as theWeb Client user interface

to communicate successfully with the Engage recorder. TheWeb Client requires Microsoft .NET 4.0 or later.

To install the .NET Framework on aWindows 7 Professional, 2003 or XP server, install the complimentary copy

ofMicrosoft .NET Framework from the Engage Pre-Reqs folder:
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1. On the server, navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-

Reqs.

2. Click on the dotNetFx40_Full_x86_x64 file to install .NET Framework.

3. When the setup wizard has opened, select I have read and accept the license terms checkbox.

4. Click Install and Finish when installation is complete.

5.2.2 Microsoft Visual C++ 2008 and 2010 - Auto-installed

Microsoft Visual C++ 2008 is automatically installed by Engage Voice Recorder installation software and does

not need to bemanually installed.

Microsoft Visual C++ 2010 is required for all Engage installations to:

l Playback calls in the timeline player for IE11, IE10, and IE9.

l Required to download an .MP3 call recording.

l Required for the Event Monitor to function.

These are the steps to install Microsoft Visual C++ 2010, if needed:

1. Navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-Reqs » Microsoft

Visual C++ 2008_2010_vcredist . Contents are zipped.
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2. Select one of the following according to the deployment's need by double-clicking the filename (ex

2010vcredist_x64) file to unzip the file.
l 2008vcredist_x64

l 2008vcredist_x86

l 2010vcredist_x64

l 2010vcredist_x86

3. Execute the file to get the Visual C++ Setup window.
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4. Click the checkbox for I have read and accept the license terms, then click Install and

5. Click Finish to complete the installation.

5.2.3 Install Sun Java Runtime Environment (JRE)

The Sun Java Runtime Environment (JRE) is required for theWindows Server 2012, 2008, 2003 and XP oper-

ating systems. The JRE is essential for the Engage JAVA client to run properly on the server.

To install the Java Runtime Environment on the Engage recording server:

1. Navigate to EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-Reqs folder.

2. Double-click on the jre-6u21-windows-i586-s.exe file to get the JavaWelcomewindow.
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3. Click Install to begin installation.

4. When installation is finished, click Close.

NOTE: If no Internet access is available, use these steps.

Sometimes the Engage server does not have internet access and the JRE will fail to install. Engage has

provided a similar program in the Engage Pre-Reqs & Tools folder which can be loaded without internet

access; however, TelStrat recommends installing the JRE instead.

To install on an Engage Server that has no internet access:
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1. Navigate to the EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Windows Pre-Reqs folder.

2. Double-click on the file rootsupd for java no access to internet.

3. Install the JRE using the previous steps.

5.2.4 WinPcap: Required for All VoIP Deployments - auto-installed

WinPCap software is automatically installed by Engage Voice Recorder installation software and does not

need to bemanually installed.

The Engage Recorder requires that theWinPcap tool be installed for any VoIP call recording.  WinPcap is the

packet capture and filtering engine ofmany open source and commercial network tools, including protocol

analyzers, network monitors, network intrusion detection systems, sniffers, traffic generators and network

testers. The tool is a component of theWireshark tool.

If needed, WinPCap can be installed using these steps:

1. Navigate to the EngageSoftware » Engage x.x Pre-Reqs & Tools NO SQL » Technician Tools Only folder.

2. Double-click eitherWireshark-win32.exe for 32-bit systems andWireshark-win64.exe for 64-bit systems.

3. At theWireshark Setup Wizard window, click Next.

4. Click I Agree at the License Agreementwindow.
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5. Click Next to get past default components, click Next to get past default additional tasks and click Next at

the default destination window.

6. Select the Install WinPCap 4.1.3 checkbox and click Install for Wireshark installation. 

7. When complete, click Next.

8. At theWinPcap 4.1.3 Setup Wizard, click I Agree the Licensing Window. Click Install. 
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9. Click Finish when install is complete.

NOTE: Manually remove the Engage Packet Driver if upgrading Engage to release 4.2 or better.

5.3 Installing Engage Server Software

WARNING: If any versions of the Engage Record software have previously been installed on this server, those

versions must be uninstalled BEFORE installing Engage Record 5.2.

There are two versions of Engage Server software available for downloading. Be sure to select the proper ver-

sion for the customer's specific deployment.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

99

From the Engage product software that was downloaded to the server folder: C:\En-

gageSoftware\EngageSuite 5.x.x there will be one of two zipped versions of software to choose from

depending on the deployment:

l 64-bit Cisco deployments, use: \Engage5.x.x\Engage 5.x.x.xx Recorder-Cisco(x64).zip\MediaKit (x64)

\Engage.

l All other deployments, use: \Engage5.x.x\Engage 5.x.x.xx Recorder.zip\MediaKit\Engage.

Install the Engage Recorder Software

1. Unzip the folder of Engage software by double-clicking on the folder icon. Select Open with Windows

Explorer and click OK. Click on theMediaKit folder to open it.

2. In the folder contents list, double-click the Setup.exe file to run the Engage installer.

3. A Security Warning windowmay appear. Click on Run.
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4. At theWelcome to the InstallShield Wizard for Engage 5.2.0window, under Install, click the Engage

Server, Client and tools link.

5. The InstallShield Wizard may install Microsoft Visual C++ 2008 SP1 Redistributable Package if it is not

already installed.  Click Install.

6. The TelStrat Engage Record - InstallShield Wizard opens. Click Next.
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7. At the License Agreementwindow, select I accept the terms of the Licensing Agreement and click Next.

8. In the Custom Setup window, expand Client and click on theWindows Desktop Application (for Engage

JAVA Client) dropdown menu box.
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9. Click on This feature will be installed on local hard drive to install the Engage JAVA client.

NOTE:  The JAVA client is used for the first initial setup and server administration only.  It is not sup-

ported as an end user client and should not be provided for users to logon to Engage with.

10. Expand Servers » Voice Recording Server and click on the VOIP Recording dropdown menu box.

11. Click on This feature will be installed on local hard drive. Click Next to install the Engage related applic-

ations. Click Next.
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NOTE: Other recording methods are available and may be selected if the deployment is using a

method other than VoIP recording.

12. At the SQL Server Locations window, enter the location of the SQL Cache Database (Server-

\InstanceName) (ex. techpub2012\ENCACHEX) in the Engage Voice Server’s SQL Server Instance Name

box. Click Next.

13. At the Login Informationwindow, select Using the built-in Local System Account.  If screen recording or

speech analytics are being deployed, then select Use a Domain User Account and enter the Engage

domain account with the domain.  Select Next.
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14. At the Security Devicewindow, select Software Based Licensing then click Next.

15. At the Ready to Install the Programwindow, click Install to begin installation.
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16. During the installation, the Communications Server Configuration (CommSrv) screen will appear.  These

settings can be applied now as defined in the SERVER CONFIGURATION (COMMSRV) SETUP topic. Configuring

them now removes one restart of the TelStrat Voice Recording Service later during the installation.

17. BEFORE CLOSING the COMMSRV tool, generate the security fingerprint file before closing the Com-

munication Server Configuration tool, as follows:

a. On the Communications Server Configuration tool, select the License tab.

b. Click theUse Soft License button and then click on Generate Fingerprint button.

c. Save the filename.c2v file (customer to vendor) on the desktop or some other location such as the

Documents folder.
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d. Email the saved customer-original.c2v file to this email address, REGKEYS@TELSTRAT.COM ,  and wait

for a reply.

WARNING:DO NOT generate another fingerprint during this time. It will not match the fin-

gerprint of the file sent to TelStrat and confuse the process.

e. When received, the reply email from TelStrat will contain a licensing file with a filename.v2c

extension.  This file could be contained in a .zip folder and may need extraction. Save this file in an

easily accessible location on the server, such as Documents. The v2c file can be applied now or at a

later date. The Engage system will use a short three (3) day temporary license to operate on until

the v2c file is applied. Refer to section RECEIVE AND APPLY THE NEW V2C FILE to apply the v2c license,

once it is available.

18. Click OK on the screen to continue the installation.

19. Click Finish when the installation process is complete. 

NOTE: Detailed step-by-step instructions for Server Configuration are defined in the Post-Installation

configuration section of this document at SERVER CONFIGURATION (COMMSRV) SETUP. 

Warning: Do not reboot the server.  A reboot of the server is required, but will be done later.

mailto:regkeys@Telstrat.com
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5.4 Install Engage SOA Services

Engage SOA Services must be present on the Engage recording server to allow theWeb Client application to

access the Engage recording server.

The EngageWeb Client uses the following services to communicate when it communicates with the Engage

Server:

l TelStrat Engage Alarm Service.

l TelStrat Engage Annotation Service.

l TelStrat Engage Configuration Service.

l TelStrat Engage Download Service.

l TelStrat EngageMass Archive Service.

l TelStrat Engage Notification Service.

l TelStrat Engage VoIP Configuration Service.

Install the Engage SOA Services

From the Engage product software that was downloaded to the server folder: C:\En-

gageSoftware\EngageSuite 5.x.x there will be a folder:

\Engage5.x.x\Engage 5.x.x.xx Services

1. Unzip the folder of Engage software by double-clicking on the folder's icon. A confirmation windowwill

appear. Select Open with Windows Explorer and click OK. A new folder windowwill open displaying a folder

named Engage 5.x.x.xx Services with some contents.

1. From the unzipped folder, click and launch the Setup.exefile to run the Engage Services installer to execute

the Engage Services setup file.
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2. The installer will appear. Click Next.

3. Select I accept the terms in the License Agreement. Click Next.

4. Install the Engage Services to the default folder. Click Next.
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5. Select Complete for the Setup Type. Click Next.

6. Click Install and Finish when the installation is complete. It may take a fewminutes to install and start the

Engage Services.
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5.5 Restart the Recording Server

Now that prerequisite software and tools, Engage Recording server software, Engage SOA Services, and web

client software are installed, restart the Engage Recording server now to complete the installation of the

Engage server software.

How to Restart

After initial installation is completed, rarely is a restart required. However, occasionally, the need arises to

restart themachine to set software such as updating the Engage TAPI software version to match that of the

CUCM version, changing any CTI Options and changing CTI Server names all require a restart for the change to

take effect.

WARNING: Only use a restart when it is clearly understood what is being affected.
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If a restart of the Engage Voice Recording Service is needed, do the following:

1. Open the Services tool on the Engage Server.

2. Scroll down to the TelStrat Engage Voice Recording Server service.

3. Right-click on the TelStrat Engage Voice Recording Server service and select Stop.

4. Wait 10 seconds, and then right-click on Start to start the server.

When not to use Restart

There is no need to restart the system when adding, modifying, or deleting port mapping (user and agent

data) via theWeb Client or with individual port mapping.
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6 Post-Installation Configurations

With all of the various software components successfully installed, post-installation configurations and tasks

must be accomplished to finish the Engage voice recorder installation. Some of these tasks are:

l Configuring the SQL databasememory limits and file systems.

l Applying licenses to systems.

l Setting up and configuring theWeb Client.

l Configuring Engage accounts.

6.1 Server Configuration (CommSrv) Setup

The Communication Server (CommSrv) Configuration program on the Engage Record server must be setup as

part of the Engage Record server installation. Configurations are set using tabs in the program. After making

all of the changes identified here, restart the TelStrat Engage Voice Recording Server service.

Most of these settings are considered one time setup and as such, do not dynamically update the record-

ing server. Therefore, a restart of the TelStrat Voice Recording Service will be required after making all of these

configurations on the Communications Server Configuration tool.

Perform these steps to complete the one-time server configurations needed on each of the following tabs:

1. Logon to the Engage Voice Recorder server using an administrator's user ID and password.

2. Launch the Communication Server Configuration (CommSrv) program by clicking on the Server Con-

figuration icon or by clicking on the Start » Server Configurationmenu command.
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3. The Communications Server Configuration window (also known as CommSrv) and its tabs will appear.

Make the following changes to the CommSrv program tabs:
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1. Email tab (Required): System alerts are a Critical Function. This tab is used to program Engage to send

alert messages to users using their email account. Enter the following, as required:
a. SMTP Server field: Enter the SMTP server's name that control's the customer's email. (ex. corp.-

telstrat.com). The SMTP Server field shownMUST be filled out in order for email alerts to work.

This can be set or modified at any time and no service restart is required.

b. Authentication Method field: Select themethod of authentication from the following and enter the

user ID and password:
l LOGIN PLAIN: Used for local login.

l AUTH LOGIN: Used for network authentication.

l CRAM MD5: Used to encrypt login requests only. Largely replaced by other secure login

methods that encrypt the entire email.

l None: No authentication required.

c. Click Apply and go to the next tab.

2. Voice Recording Database tab (Required): Defines the location and authentication for the recording data-

base.
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a. Check the SQL Server\InstanceName. If this is not already correct, reconfigure it now (ex. doc51\en-

chachex).

b. Set SQL Server Authentication Type by selecting either theWindows or SQL button. Enter the SQL

authentication User ID and password, if using SQL authentication.

c. Set SQL database type by selecting the button for SQL Express or SQL. Engage uses this inform-

ation to limit the call cache database to either 2M records (SQL Express) or 7M records (SQL). Note

that mass archive supports an unlimited amount of call records as long as sufficient SQL storage is

available.

d. Xdays for Call Records: If the customer has a requirement to delete calls after so many months or

days, you must configure that number of days in this location and the same number of days in the

Cache configuration tab.

e. Data Source Provider: Set to the default Engage value unless instructed otherwise.Click Apply and

go to the next tab.

3. Cache tab (Required): Sets the location and authentication for recorded .WAV file storage.

l Call Cache Age Limit (in Days): If the customer has a requirement to delete calls after so many

months or days, you must configure that number of days in this location and the same number of
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days in the Voice Recording Database tab.

l File Keep Flag: If the customer needs to keep specific audio recordings in the call cache and prevent

them from being purged, select this check box and enter a word to use such as “keep” in the asso-

ciated text box. You must also select a folder that will be used to store these recordings. Users can

enter the keep phrase in Remark1 or Remark2 and Engage will keep the recording rather than purge

it when space is exhausted.

l System Partition Reserved Space: This should not be used as it only applies if the C:\ drive is used

to store calls which is not recommended.

l Allowed Cache Drives: For new installations, select one partition that is dedicated to audio call stor-

age. When referencing this tab on an existing deployment, Engage automatically detects the pres-

ence of any drives that contain a \RecordingCache folder and will select these. Do not select C:\.

Multiple drives should not be selected except for legacy deployments where server storage was lim-

ited due to available technology at the time.

l Click Apply and go to the next tab.

4. Archiving tab: Sets the type and location for archives of recrodedcalls.
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l Select the type of archiving.
l No Archive button is selected now for ALL new deployments. Prevents use of Legacy mass

archivng.

l DVD Archive button: NOT USED for new deployments.

l Mass Archive button: Refers to first generation Mass Archive, which has a limited feature set

and is not used for new deployments.

l Mass Archive Storage Location: Only used with the legacy first generation mass archive

l SQL Credentials: Only used with the legacy first generation mass archive

l Click Apply and go to the next tab.

5. Security tab:

l Authentication: Do not select UseWindows Integrated Security. This only applies to the internal

service account used by the web server, live monitor, and a couple of Administrator accounts used

to access the JAVA client.

l PCI File Encryption: Refer to the Encryption Configuration Guide for setting up file encryption
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l Data Security Configuration: This feature supports signing audio recordings, verifying the integrity

of a signed audio recording, and notifying the user during playback of verification errors. To use the

Data Security Configuration option:
l Select Signing On, and then select Verify Certificates PKI and verify the pop up indicates

verification is OK

l Select Verification On, and then select Complete Certificates PKI. Verify the pop up indic-

ates completion OK.

l Select Notification On, and then Renew Key Certificate. Confirm that you wish to renew the

key certificate and then verify the renewal completed successfully.

l Click Apply and go to the next tab.

6. Screen Capture tab: This tabis only used when optional screen capture licenses are purchased.

l Continue Screen Capture when a call is on hold: Enable this if you would like to continue record-

ing the workstation when a call is placed on hold.

l Default Agent Wrap up Time(s): Enter a time in seconds for typical wrap up time. Wrap up time is

how long the recording server should continue screen recording after an audio call completes. Note

that if a new call is presented to the agent, the existing screen capture session will end and the new
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call will be recorded with screen capture. The wrap up time can also be set as part of the recording

schedule. Wrap up time is no longer managed on an individual agent basis.

l Local Server: Select Local Server if Proxy Gateway software will be installed on the Voice Recording

server. This is only an option for sites up to 200 recording channels.

l Remote Server 1-6: Enter theDNS name or Static IP address of up to 6 screen capture gateway serv-

ers.

l Click Apply and go to the next tab.

7. Live Monitor tab:

l Enable Live Monitoring checkbox: This should be enabled at initial installation as enabling it after

the installation requires a maintenance window to restart the Voice Recording Service.

l SIP Server Address: Enter theDNS name or static IP address of the voice recording server.

l SIP Server Port: Use the default value of 6060.
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l Click Apply and go to the next tab.

8. Misc tab:

l ACD Agent ID in All Call Records: Enable this setting for any contact center (ACD) deployments.

This setting will help add the Agent ID to any calls placed by the agent while they are logged into the

Contact Center. When Engage is deployed with some systems, the agent ID will not be placed into

the call record for outbound calls for example unless this is enabled.

l ACD System: Enable this setting for any contact center (ACD) deployments.

l Cisco Extension Mobility: Enable this setting only for a Cisco UCM TAPI deployment that uses the

Cisco Extension Mobility Feature. This is required for Engage to interact with themobility server to

obtain mobility user ID for new calls.

l No Empty Recording Alarm if Call Duration < 3 seconds: Change this value to 10 seconds. This will

prevent Engage from sending unnecessary alerts for calls that were so short recording could not be

established before the call disconnected.

l Include All Ports in Active Calls Query Response: Leave disabled by default. Enable this to see all

ports in the Active Calls Screen. This is introduced with the screen-only recording feature, and it

must be set for screen-only recording. This can be set for any deployment, however the active calls

screen loading will be slowed.
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l Click Apply and go to the next tab.

9. License tab (Required): Enable hard dongle or soft dongle licensing management:

l Use Soft License: This is the default setting for all new installations. Refer to the documentation on

applying the software license for additional details.

l Use Dongle: This is for legacy customer sites or highly secure sites that do not allow any network

access to the Engage Record server.

l Click Apply and go to the next tab.
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10. Cluster tab:

l This tab will only be setup as part of an Engage Record clustered server installation.

11. SoftPhone & CE Tracking tab:

l This tab is only used with some CS 1000 VoIP deployments. The CS 1000 configuration will configure

this tab if required.

12. Click OK to close the Communications Server Configuration tool.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

123

13. Restart the TelStrat Engage Voice Recorder Service:
a. Open the Services tool on the Engage Voice Recording Server.

b. Scroll down to the TelStrat Engage Voice Recorder Service.

c. Right-click on TelStrat Voice Recording Service and select Stop.

d. Wait 10 seconds, and right-click on Start to start the server.

6.2 Change the FromEmailAddress Registry Value

Each voice recorder server's Registry contains a value entry (EmailFromAddress) where a customer can

provide a FROM email address in the header of emails sent TO assigned email addresses designated to receive

email regarding events from the Engage Voice Recorder. This FROM address must be a valid email address

that can flow through the company's SMTP email receiving and delivery processes.

Change the Entry in the Engage Voice Recorder

This Registry entry must be changed to reflect the customer's specific company address in the FROM part of

the email header. If not changed, then the engage@telstrat.com default address will be inserted as the

FROM address in server produced emails.

Change the Entry in Multiple Engage Voice Recorders

If the customer has multiple recorders in the deployment, EACH recorder's Registry entry needs to be

changed and provided the same address. A unique email address, per server, is not needed since the text in

the body of the event email message will note the server name creating the event.

An example of a critical server produced message is:

From: engageABB@corpname.com [mailto:engageABB@corpname.com (address retrieved from Registry
entry)

Sent: Monday, August 10, 2015 10:37 PM

To: Tom Clark (address provided by Web Client)

Subject: TelStrat Critical Email Notification
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TelStrat Critical Email Notification received from Machine: TSEN-JST-01 EventID: COMM0049 at 8/10/2015
23:37:8. Description: Unable to connect to Gateway Server - TSEN-JST-01 - (affected server name is TSEN-JST-
01-)

To make this registry change:

1. From the Start menu, Open a Command Run box and enter Regedit and click OK to launch the Registry

Editor. Be very careful in this area of the server. Make no changes other than this one value change.

2. When the Registry Editorwindow appears, open the various folders to get to the following location:
l Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\TelStrat\Com-

mSrv\EmailFromAddress

3. Click on the (Default) entry and right-click to get the pop-up menu and click onModify...
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4. In the Value Data: field, enter a VALUE in form of the company provided email address (ex. engageVR@-

corpname.com) and click OK to make the change.
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5. Close the Registry Editor.

6.3 Apply New Soft License V2C File

For a new deployment and product order, the steps to obtain and apply soft licenses are:

l Create an Original customer to vendor file (filename-original.c2v) (a fingerprint) and send it to TelStrat.

l TelStrat will return a vendor to customer file (filename.v2c) to the customer.

l The customer must create a final customer to vendor (filename.final.c2v) file and send it back to TelStrat. 

WARNING:DO NOT generate another fingerprint during this time. It will not match the fingerprint of the file

sent to TelStrat and confuse the process.

1. When received, the reply email from TelStrat will contain a licensing file with a filename.v2c extension.  This

file could be contained in a .zip folder and may need extraction. Save this file in an easily accessible location

on the server, such as Documents.
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2. Return to the Server Configuration window and the License tab and click the Apply License Key button.

3. TheOpen windowwill display. Navigate to the location of the saved .v2c file just received from TelStrat,

select the file and press theOpen button. The Apply V2C Filewindow should appear.
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4. Applied V2C file successfully! confirmation windowwill display. Click OK.

5. Click theGenerate Fingerprint button to generate a filename-final.c2v file to email back to TelStrat
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6. The Save As windowwill display.  Name the file using the customer’s name followed by “- Final.c2v”

(Example:  Jane’s Bakery–Final.c2v).  Navigate to a location that is easily accessible and that will allow for

emailing to TelStrat.  Click Save.

7. Email this filename-Final.c2v file to this email address: REGKEYS@TELSTRAT.COM .

NOTE: TelStrat will keep this filename-Final.c2v on file. It will be used to generate any future license key

updates such as seat counts and / or maintenance renewal expiration dates.

6.4 Configure the SQL Server

Now that all required software has been installed on the server platform, it is time to set the configurations of

the various software components to that Engage can begin recording calls and call data.

Two SQL configurations require attention and are needed.

The first is for memory limits. Thememory of the Engage SQL Instancemust be limited if any other Engage

components are on the same SQL server. This will ensure Engage has access to available memory. 

The second is configuring the four databases that Engage will use to record calls and call data.

6.4.1 Limit SQL Memory

If any other Engage component software is running on the SQL server, thememory needs to be limited to

make sure Engage has access to enough memory to operate correctly.

To set the SQLmemory limits:

mailto:regkeys@Telstrat.com
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1. Start the SQL Server Management Studio.

2. Login using either SQL Authentication with the login and password setup previously in the SQL install or

login usingWindows Authentication with the account presently logged into the server. Click Connect.  The

SQL Server Management Studio pops up.

3. From the Object Explorer, right click the <Server\InstanceName> and open Properties.
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4. The Properties window <Server\InstanceName> appears.

5. On the Server Properties left window pane, click onMemory. 

Change theMaximum Server Memory to one of the following:

If using SQL Express edition, the setting is:

l 1024 – 1GB.  SQL Express edition limits memory usage to 1,024MB (1GB).
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If the SQL Server used is not dedicated and running on the same server as other Engage software, then set

the SQLmemory limit to 25% of available memory as follows:

l 1000 – (1GB) if the server has 4GB of total memory.

l 2000 – (2GB) if the server has 8GB of total memory.

l 4000 – (4GB) if the server has 16GB of total memory.

If the SQL Server is dedicated then Maximum Server Memory is not required, but could be set to 75% of avail-

able memory.

6.4.2 Configure SQL for Engage Databases

NOTE: The following steps cannot be completed until the Engage Recording server has successfully

started and the Engage databases have been automatically created.

Within the SQL server, Engage requires the following databases:

l Config – Recorder configuration

l SrecordingCache – Call records for call cache (non-archive)

l ActivityLog –Must be present

l DVDList –Must be present, but only filled if DVD archiving is used

l Engage - In addition, the web server requires a configurable SQL database which is typically named with

the same name as the virtual directory such as Engage

l Mass Archive Databases – In addition, each time an archive is added Engage automatically creates a data-

base, but the following settings must be applied to this new database.

This procedure will make the following changes to the SQL databases:

l Recovery model is set to Simple (to permit high-performance bulk copy operations while keeping log

space requirements small - should be set to simple by default).
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o Customers may choose to set recovery model to Full, but the transaction log must bemanaged fol-

lowing SQL best practices.

o If the transaction log becomes full, new calls will not be archived, and data loss could occur if the call

cache fills up and starts purging.

l Auto Close is set to False (so each database will stay open and not close due to inactivity).

Follow these steps for each of the four new Engage Recorder databases:

1. Logon to the SQL Server Management Studio.  Double click on Databases.  The list of databases expands. 

Note the databases named: ActivityLog, Config, DVDList, and SRecordingCache. 
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2. From the Object Explorer, click Databases » Activity Log and right click on Properties. On theDatabase

Properties - ActivityLog window, click Options.  Make sure Recovery model is set to Simple and change

Auto Close to False. Select OK to save changes.

3. From the Object Explorer, click Databases » Config and right click to open Properties. On theDatabase

Properties - Config window, click Options. Make sure the Recovery model is set to Simple and change

Auto Close to False. Select OK to save changes.

4. From the Object Explorer, click Databases » DVDList and right click on Properties. On theDatabase Prop-

erties window, click on Options. Check and make sure the Recovery model is set to Simple and change

Auto Close to False. Select OK to save changes.

5. From the Object Explorer, click Databases » SrecordingCache and right on Properties. On theDatabase

Properties - SRecordingCachewindow, click Options.  Make sure the Recovery model is set to Simple and

change Auto Close to False. Continue with the next step before saving changes forSrecordingCache
properties.

6. On theDatabase Properties - SRecordingCachewindow, click on Files to configure the Autogrowth for

the SRecordingCache_Log.
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7. In theDatabase Properties - SRecordingCachewindow, click on Files.

8. Locate the SRecordingCache_Log Logical Name in the table and click on the (…) button in the Autogrowth

/ Maximize column.

9. In the Change Autogrowth for SRecordingCache box, underMaximum File Size, clickLimited to (MB) and

enter 2048 for a maximum of 2GB files.

10. Click OKto save the size and click OK again to save the SRecordingCache Options changes.

11. Close the SQL Server Management Studio.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

136

6.5 Create SQL Account for Engage

This step will create a SQL account on the SQL server for Engage. The account must be created differently

depending if Engage will use SQL Authentication or Windows Authentication to connect to SQL.

6.5.1 Create SQL Account for Windows Authentication

This procedure creates an account on the SQL instance for Engage to connect to SQL usingWindows

Authentication.

Perform the following steps on any SQL Database instance(s) that Engagemust access.

1. Launch and logon to the SQL Server Management Studio. Go to and expand instance » Security » Logins

and right-click on Logins.

2. Click New Login and the following pop-up windowwill appear:



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

137

3. If SQL is on the local Engage server, then in the Login Name field, typeNT AUTHORITY\NETWORK SERVICE

or select Search and the following pop-up will appear:

4. Type in Network Service in the Enter the object name to select field and select Check Names and select

OK.
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5. Access Server Roles on the left hand side of the window.

6. For simple administration, you can check the SysAdmin role checkbox. Click OK to finish.

A More Secure Option

Amore secure option is to choose a subset of databases that theWeb Client can access under the User Map-

ping option.
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1. On the left hand pane, select User Mapping and the following screen will appear:

2. Select any databases that theWeb Client must access such as theWeb Client database or the Recorder

Databases, SrecordingCache and any Mass Storage databases.

3. Click the db_owner checkbox.

4. Select OK to save the user.

6.6 Create SQL Account for SQL Authentication

This procedure creates an account on the SQL instance for Engage to connect to SQL using SQL Authentic-

ation (logon and password).
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Perform the following steps on any SQL Database instance(s) that Engagemust access.

1. Launch and logon to the SQL Server Management Studio. Go to and expand instance » Security » Logins

and right-click on Logins.

2. Click New Login and the following pop-up windowwill appear:
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3. Click on the SQL Server Authentication button.

4. Enter the Login name that Engage will use to logon to SQL for this instance (ex. Engage).

5. Enter the password that Engage will use to logon to SQL for this instance. Confirm the password.

6. Access Server Roles on the left hand side of the window.

7. For simple administration, you can check the SysAdmin role checkbox. Click OK to finish.
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6.6.1 A More Secure Option

Amore secure option is to choose a subset of databases that theWeb Client can access under the User Map-

ping option. To do this:

1. On the left hand pane, select User Mapping and the following screen will appear:

2. Select any databases that theWeb Client must access such as theWeb Client database or the Recorder

Databases, SrecordingCache and any Mass Storage databases

3. Click the db_owner checkbox



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

143

4. Select OK to save the user

6.7 Configure Service Accounts via JAVA Client

These steps verify the Engage voice recorder is running and configures two necessary Engage service

accounts,WebClient and LiveMonitor. 

l WebClient is used by the web server to connect to the recorder.

l LiveMonitor is used by the SIP service to connect to the recorder for live monitoring. 

1. Logon to the recording server and navigate to Start » TeStrat » Engage » Engage Client JAVA applic-

ation.

2. Login with the user nameDEFAULT and no password.

3. The System Users window appears with only the Default User ID listed.
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4. Click on Configuration and right click on System Users and click Create.

5. At the Engage: New System Users Settings window, enter the following:

a. The name of the system, such as TelStrat Web in the First Name and Last Namefields.

b. TypeWebClient into theUser ID field. Note that this User ID will be used with theManage Record-

ers screen.

c. Check the System Administrator box.

d. Click on theMore Info button associated with Alarms.

e. In the Alarm Notification Recipientwindow, enter an email distribution list address used by the IT

department to receive email alerts. 
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f. Click OK then click Add. 

g. The new user appears on the System Users list.

NOTE:  TelStrat suggests the use of an email distribution list already in use by the IT department

rather than individual email accounts that can become obsolete as personnel changes occur in the

organization.

6. Change the password on the newWeb Client user account.  In the System Users window:
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l Under theUser ID column, right click onWebClient and ClickModify.

l In theModify System User Settings window, enter a new password in the Password box.

l Repeat the new password in the Confirm Password box.

l ClickModifythen OK, then Exit.  Use this new password on the next Web Client login session.
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7. Create the LiveMonitor service account using the same system name in the First and Last Name fields. 

a. In the User ID field, type LiveMonitor.

b. In the Password field enter LiveMonitor and check the System Administrator box. 

c. Click Add.  Be sure to change the password on this account.

8. When the service accounts are added, review the accounts in the System Users window.

9. Close the Engage Client.

10. Open a browser and access, for the first time, theWeb Client Logon Dialog screen and enter the following

information to access and configure the built-in user account. On the screen:

a. User ID: Enter default.

b. Password: Enter default.

c. There will be a prompt to change the built-in password to something other than default.

d. After changing the password, logon again with the new password.

e. The presented Playback Logwill be empty since no call recorder has been configured yet.

f. Click Add

11. On theWeb Client, click on Administration » Users » New User to create users.

12. Create a system user for the Recorder Administratorwho will bemanaging the recorder. This will need to

be a System Administrator account as well.
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a. First name: Enter Recorder.

b. Last name: Enter Admin.

c. User ID: Enter RecorderAdmin.

d. Local Authentication should be selected.

e. Available Roles: Highlight Administrator and click the » symbol to assign Administrator to this

user.

f. Click OK then Exitwhen finished.

13. If live monitoring of calls is desired, create another system user account for LiveMonitoring (ex. LiveMon-

itor). Click Add. Click Exit when finished.

6.8 Configure Anti-Virus Real-Time Exclusions

This step can only be completed now that the TelStrat Voice Recording Service has started for the first time

and created the recording folder.

Engage creates a large amount of voice recording files.  The folder that stores the files is typically D:\Re-

cordingCache and this folder should be excluded from anti-virus real-time file checking to avoid server per-

formance issues.

Real-time protection, on-access scanning, background guard, resident shield, autoprotect, and other syn-

onyms refer to the automatic protection provided by most antivirus, anti-spyware, and other anti-malware

programs.
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This monitors computer systems for suspicious activity such as computer viruses, spyware, adware, and

other malicious objects in 'real-time', in other words while data is loaded into the computer's activememory

such as when inserting a CD, opening an email, or browsing the web, or when a file already on the computer is

opened or executed.

The scanning to set the exclusion from is the real time or on-access scanning, such as scanning a file when it is

created or new to the server.

On demand (scheduled) scanning of files when the system is idle or nearly idle would be fine.

It is recommended to exclude the following items and components from real time scanning:

l The C:\Program files (x86)\TelStrat directory.

l The SQL DB and its log file directories.

l The TelStrat WAV cache directories.

l Proxynetworks screen capture cache directories, if using screen capture.

6.8.1 Logging On for the First Time

If theWeb Client was successfully installed, it will be able to be launched from a browser. The URL to access

theWeb Client is usually in this format: http://engage-server-name/Engage where engage-server-name is

the server name for the recorder (ex. techpub2012 or VoiceRecorder).

If logging on for the first time from the Engage server itself, in a browser on the server, enter http://-

localhost/Engage to access theWeb Client.

If logging on for the first time from a different workstation, in a browser on the workstation, enter http://en-

gage-server-name/Engage to access theWeb Client.

The first time login will require the user to change the default password before beginning Administration page

configurations.

To do this after accessing theWeb Client via the URL:
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1. Enter the User ID as default .

2. Enter the password as default.

3. Click OK.

4. Prompting will occur to change the built-in password to something other than default. After changing the

default password, logon again with the new password.

5. The Playback Log page will display and be empty since no call recorder has been configured for theWeb

Client yet. Continue to the Administration configuration section.
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6 Recorder Setup

This section contains instructions required to setup the Engage Voice Recorder to record and playback audio

calls using tabs in theWeb Client and the CommSrv program.

6.8.1 Configuring Recorders on the Web Client

On theWeb Client, theManage Records icon is used to connect the web server to each Engage Record

server.

1. On the web client, navigate to Administration » Setup tab and click on theManage Recorders button. 

2. Click New.
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3. Enter the following into theNew Recorder – Recorder Connection fields:
l Recorder ID: A name used to refer to the recorder.

l Recorder Address: The DNS name or static IP address for the recorder. Note that failure to resolve

by DNS name can be worked around by entering the static IP address of the recorder.

l Windows Authentication or Local Authentication: Set to Local Authentication for almost all new

deployments. Some legacy deployments may have 3rd party software that authenticates to the

Engage Record server with Windows Authentication. In this case refer to the User Guide / Manage

Recorders section for detailed instructions.

l Login: EnterWebClientwhich is the login ID of the Service Account created on the recorder ded-

icated for the web server.

l Mode: Mode is Active unless connecting to the file store and database of a recorder that is no

longer intended to record new calls.

l Recorder included in searches by default: Leave this selected by default unless this is a redundant

2N recording server that is only included by searches when users specifically request it.

l Import Config from recorder: Do not select this checkbox for a new installation. This option is for

upgrading from 3.6 or previous releases only. Refer to the upgrade documentation before attempt-

ing an upgrade.

l Default role for system users: Grayed out but filled with supervisor.

l Voice Recording Database: This information will populate automatically as long as the Con-

figuration Service is installed and running on the Engage Recording server. If it does not populate

after leaving the recorder address field, then escalate for help.

4. Click OK.

5. If the information used is correct and the installation has proceeded successfully, the Recorder Status and

Recorder Version column fields will be filled with status (ex. Online) and a version number (ex. 5.2.0.16).

6. Click Close to exit.
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6.9 Verify VoIP Module Configuration Meets Requirements

Verify that the VoIP module configuration meets the customer's specifications and needs.

Use the Engage VoIPEngine Config Console to configure the platform that the Engage Recording Service will

integrate with.

Each vendor's platform has unique elements, settings and configurations to work with Engage properly. Use

the Configmenu command to call up the VoIP Configuration » CTI Option drop-down menu to select the

vendor's platform for the Engage end of the recording connection. This is an example of a BroadSoft

VoIP system deployment.
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After configuration, check for any obvious issues that may be preventing recording. Usually, these issues can

be traced back to the initial setups and configurations.

Some examples of out-of-specification issues to look for are:

l Too many softphones for an Avaya red installation have been configured.

l Each customer has procured a virtual phone in the Avaya CM for each soft phone configured. 

l Check VoIPInfo.logmaking sure there are not unnecessary registrations (ex. soft phone registration fail-

ure events).

l Ensure auto learning is enabled, whenever possible.

6.9.1 Web Client VoIP Tab

Once the one time VoIP configuration has been completed using the VoIP Configuration Console for the plat-

form being deployed, the VoIP devices (telephones) to record can bemanaged from the web client at the

Recorder Admin » VoIP tab.

This is documented in the specific Configuration Guide for the voice platform (ex. Avaya CM, Cisco UCM, Nor-

tel CS 1000, etc...) being integrated. There are differences for each voice platform.

6.9.2 Mass Archive

All Mass Archive storage locations should be defined first before the recording schedule so that the recording

schedule can be used to map sets of calls into specific archives, if desired. 
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Themass archive defines the storage location and options such as how long to retain calls and limiting the sys-

tem to archive only at off-peak hours for maximum system performance. 

Refer to the Setup - Mass Archive document and the customer's prerequisite documentation for full details

on setting up and activating Mass Archives.

6.9.3 Recording Schedule

Engage requires a recording schedule to record any calls. To record all calls, build an All Calls recording sched-

ule using the following:

1. Logon to the web client and access the Recorder Admin » Schedule Recordings tab.

2. Select New Schedule to create recording schedules.

3. Type in a name for the recording schedule (ex. All Calls).

4. Verify the Active button is selected.

5. Ifmass archive is required, select the Archive Recorded Calls to checkbox. You must select the archive

from the drop down box which contains a list of pre-defined archives. Archiving can be setup later, but as

part of setting up the archive you must modify the recording schedule to select the archive. Any calls recor-

ded without an archive selected will not be archived.

6. Select OK.
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Engage is typically deployed to record all calls on monitored phones. However, Engage includes a configurable

recording schedule rules which includes:

l Exclude specific extensions (for privacy)

l Time of Day

l Date ranges

l Extension

l Calling number (ANI)

l Dialed Number (DNIS)

l 1 of n

l Duration based

l Day of the week

l Agent Group

l Agent ID

Refer to the Schedule Recording section of the Administration Activities document for setting up more com-

plex recording schedules.
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When archiving of calls to the onlinemass storage, be sure to, first, create the archives so the recording sched-

ule can reference the archive. When calls are recorded, the calls will be sent to the archive which is defined for

thematching recording schedule.

If a call meets multiple recording schedules that define different archive IDs, then the longest duration archive

will be selected by the software.

The customer's prerequisite documentation will provide the information needed to set up recording sched-

ules.

6.9.4 Ports

Engage ports will reference specific VoIP devices (telephones typically). For example, a unique extension may

be configured as a VoIP port mapping on Engage port number 2400:001. The port number is 2400:001which

consists of a board ID (2400) and recording channel (001).

Engage port numbers are required for configuring the following add-on features that require a workstation

mapping:

l Screen recording

l On Demand Recording Client (ODRC)

l Desktop Analytics (DA)

For non-ACD calls, Engage port numbers can bemapped to user accounts to define which calls a restricted

user may playback. Deployments with contact center agents typically assign groups of agents or individual

agent IDs to user accounts, but if agents are not present, ports can be assigned to user accounts to control

which calls a restricted user can playback. In this case it is advantageous to assign a name to a port to make

administration easier.

When setting up ports for non-contact center deployments, it is recommended to enter a name for each port

that is used when assigning ports to user accounts. For example, name a port Nurse Station1, and then when

creating a user account for the nursing manager, you can assign the port with this name to themanager.
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Engage port numbers can be used to allocate Evaluation Licenses if there aremore agents than evaluation

license purchased.

Note that users can be granted unrestricted resources to all calls, and these user accounts do not require port

assignment.

If any of these conditions aremet, configure the Engage ports for the recorded devices.

6.9.5 SMTP Server Settings

The Engage Voice Recorder sends notifications of issues it encounters in the form of emails. Two con-

figurations are needed for the feature to operate correctly.

Communications Server Configuration (CommSrv) setup

The Engage server's Communications Server Configuration (CommSrv)must be configured with the cus-

tomer’s SMTP server information to be able to send email alerts (error events). 

NOTE: If this is setup prior to adding theManage Recorders connection, the SMTP server information will

autofill into the web client's Setup Email Settings. However the From Address should still be configured

1. In the CommSrv tool, verify the Setup Email Settings and the Server Configuration SMTP are entered.
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2. On theWeb Client, configure the SMTP Server Name and From Address on theWeb Client's Email Set-

tings.

NOTE:  This information can be configured without restarting the Voice Recording Service.

6.9.6 Configuring Live Monitoring

Refer to the SETUP - LIVE MONITORING document for more detailed step-by-step instructions and troubleshoot-

ing for setting up livemonitoring.

If LiveMonitoring of active calls is required, the Server Configuration and the SIP Servermust be configured

with a dedicated IP address and firewall ports.

To configure live monitoring:
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1. Open Start » TelStrat Engage » SIP Server Configuration. Click on Config in themenu bar.

2. Enter the IP address of the recording server.

3. Leave Threads Per Processor at 1 and Port as 6060.

4. Enter the LiveMonitor service account ID and password.

To configure Voice Relay Server setting:

The Voice Relay Server Settings are required if the SIP server needs to be enabled for LiveMonitoring over the

Internet, meaning the SIP server is installed and configured on a public facing server, generally the IIS server

hosting the Engage web UI. 

The following steps detail how to complete the Voice Relay Server settings.

1. IP address is the server’s public facing IP address where the SIP server in installed.

2. Port is the server’s public facing port for LiveMonitoring transport.  Firewall rules need to allow both

TCP/UDP rules for this user definable port.
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3. Forward Port is the port that must match the LMRelayPort registry setting explained in the above related

prerequisite.

4. Click OK and Exit.

5. Open Start » TelStrat Engage » Server Configuration. On the Live Monitor Tab of the Communication

Serverwindow:
a. Check the Enable Live Monitoring checkbox.

b. Enter the IP address in the SIP Server Address text box. 

c. If enabling Voice Relay Server, the IP address will match the configured IP address of the Voice Relay

Server Settings IP address in the SIP server configuration.

d. Enter the port number in the SIP Server Port text box.

e. Click OK.

Any changes to the Communication Server window require a restart; however it is acceptable to make all

changes prior to restarting the server.
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6.10 Administration

The training will include a review of the following administration tabs of theWeb Client:

Admin » Users

l Show the administrator how to Add / Manage User Accounts.

l If agents will logon to retrieve their calls, setMy Agent ID for any agents.

Admin » User Roles

Go over the User Role Permissions for roles that are in use.

Discuss with the customer which roles should have the following permissions:

l Unrestricted Resources –Which users should be able to playback any call recording? If there aremul-

tiple QA or top level supervisors, then be sure to grant Unrestricted Resources permission to roles

assigned to those users.

l Download Calls – Disable except for a few users

l Playback URL – Suggest enabling this for most users so they can email URL links to calls which are

secure. These URLs can only be played back by recipients that have access to the customers network.

l Delete Calls –What users if any should have this permission.

Admin » Agents
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l Explain that agent names populate based on call records that have an Agent ID.

l Agent names can be added after the call is recorded and they will then appear for next user logon in the

Playback Log

l Agent ID recycling is not supported in this release. The currently provisioned agent namewill appear in the

Playback Log

l Set Agent ID to appear in all call records in server config under Misc. tab.

l Evaluation licenses should be applied to agents unless there are too many agents due to multiple shifts

(use Port licenses instead).

Admin » Dialed Numbers

This is typically only required for outsourced contact centers that share agents across multiple projects or cus-

tomers. This can be used so a supervisor might only have rights to playback calls for a pre-defined list of dialed

numbers (incoming numbers) for a particular project or customer.

Admin » Playback Groups

l Playback Groups can contain agents, dialed numbers, mobility users from multiple call recorders. Record-

ing Groups are stored on the recorder and cannot contain resources from multiple recorders. Recording

Groups can be referenced by a recording schedule or for assignment to a user account, but Playback

Groups can only be used for assignments to a user account.

l Agents should be placed into Playback Groups and then assigned to any supervisors that are not granted

the Unrestricted Resources permission.

l Agent groups are needed for the dashboard to display data by group and to compare agents within a

group.

l Consider creating an “All Agents” group especially if no business users were granted Unrestricted

Resources permission.

Audit Trail
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l Show how the audit trail tracks who is playing back, live monitoring, or deleting calls. The call is tracked as

well.

Setup Tab consists of these areas:

Manage Recorders

l View the recorder connection. Show how the web client connects to the recorder using a service account,

and the recorder database location is listed to help find it for SQL backups

Database

l This tab shows the location of the application (web) database

Email Settings

l Review the SMPT server information located here and verify the same information is configured in Server

Config under Email on the recording server.

l Configuring this via the web client will also push the same configuration to Server Config Email tab.

l The web setup SMTP settings are used for emailing calls, evaluations, or reports.

l Server Config email setting is used for emailing system events.

Display Settings

l Hide ACD Agents: Unchecked by default. Select if this is a non-agent deployment.

l HideMobility Users: Un-check only for Cisco UCM deployments if the customer uses extension mobility.

Logoff and logon to the web client to add the Admin >Mobility Users tab

l Hide Find Related Calls : Un-check for Cisco UCM, Avaya ACM, CS 1000, and ShoreTel. Leave set for all oth-

ers. If un-checking, then logoff and logon again so Tracking ID is available as an available column.

l Configure Default Playback View and explain that each role can be set as well.

l Un-select port names or move to the right past agent name
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l Typical recommended setup is for a contact center:
o Date

o Start Time

o End Time

o Recording Duration

o Direction

o CLID

o Dialed Number

o Direction

o Agent First

o Agent Last

o Agent ID

o Remark1

o Remark2

o Recording Status

l Remove any unused columns such as encryption, screen capture, or archive status.

l Users will not be updated unless they select Restore Default View from Playback Log settings.

Playback URL Settings

l Verify Enable URL Playback is enabled

Local Password Security

l Configure with the customer if users will be using local authentication

Application Settings
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l Review the inactivity timer & web content storage folder

6.10.1 Bulk Data Import (Users Data)

This release of Engage supports importing users and their data from an XML file. Completed by the customer

and TelStrat during the pre-installation planning effort, theGeneral_Site_Form_Rls5.1 Users page is used to

collect and sort all of the customer's users for this deployment. It must be completed prior to installation as it

is a data source regarding users. It is also used to copy and paste that user data INTO the XML file for quick

insertion into the system via a bulk data import action.

For new Engage system installations or for bulk adding of additional users, use the following procedures:

Create Roles and Groups

Use the EngageWEB CLIENT ADMINISTRATOR'SGUIDE to get more details on how to create new user roles and

groups. Prior to the Engage system going online, customers will need to:

1. Create all user roles on theWeb Client first. This is important. Any users that use a specific role will not

import into the new or updated Web Client unless that role exists already.

2. Create all user groups with names only (membership lists can be empty). This is important. Any users that

aremembers of these groups or have permission to these groups will not be imported properly unless the

group already exists.

Export Users Data into an XML File
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1. Logon to theWeb Client and go to the Administration » Users tab.

2. Select Export Data to export the user list and Save this .XML file. It is important to always do the export

data from the system once the basic system Setup is complete and has shown or hidden ACD Agent ID and

Mobility User IDs. The file will be found in the server's Downloads folder unless pointed someplace else.

Note: The exported file for a new installation will only include the default user account (used at startup) plus

any other users that have already been added during the installation.

Place New User Data in the File

Depending on server software, the XML file may need to bemoved to a computer system with Excel available.

When the file is ready to be worked:

1. Open the exported .XML file using Microsoft Excel 2010 or newer. The Properties tab of the file will offer

choices of programs to open it with. Set it for Excel.

2. When prompted by Excel, open the file as an XML table by clicking the As an XML table button.
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3. Select Yes to create a schema.

4. The file contents will appear as columns and line entries. Remember that a NEW system will only have the

default user entries and any other users that were programmed (ex. default, eadmin and recadmin).

5. Select then Copy the user information from theGeneral_Site_Form_Rls5.1 Users page of the worksheet

and Paste it into to XML file.
l Make sure to have the customer fill out the Excel workbook prior to this task. The page has places

for User Roles and Teams.

6. After pasting in the customer supplied user information, Save the file as an .XML file from Excel. Select

Continue to save as .XML.

Importing the XML File of Bulk User Data
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1. Back on theWeb Client, go to the Administration » Users tab, select the Import Data icon to get the

Import Users Attachmentwindow and browse to find the .XML file that contains the saved additions and

changes for bulk user data import to Engage . The file may need to be transferred back to the Engage

server, if it data entries wer performed on another machine.

2. Any existing data being written over by the process will appear as a an error in a warning window. Select

Continue.

3. After import, the screen will refresh to show the NEW users and their data that have been added.

Note: Any user roles and user teams referenced by the .XML file must exist before importing the data.

6.10.2 Setup Tab and E-Mail

All sections within the Setup tab should be configured for the installation as follows:
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NOTE: Setup options are described in the Administration Activities guide that is part of theUser Guide

online help under Setup & Administration.

l Database Settings
o View the location of the application (web) database which gives the SQL server and sQL instance.

This is useful to help find the location of the database before backing it up.

l Email Settings
o Email settings are required for emailing calls by URL, call recordings .WAV files, evaluations, and

reports. There is a similar setting on the recording server that is used to email system events. Both

should be configured with the same SMTP Server Name.

o From Address only applies to emails sent by the application software. A similar setting is available

for the recording server for system alerts, but it can only be configured in the registry.

l Display Settings
o Hide Evaluations tab

o Hide Recorder Admin » VOIP tab

o Hide Recorder Admin » Ports tab

o Hide ACD Agents – This should be selected only for non-contact center deployments
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o HideMobility Users – This is hidden by default, but should be de-selected for Cisco UCM deploy-

ments that use the Cisco Extension Mobility feature.

o Hide Find Related Calls – Engage supports Find Related Calls for the following integrations:
l Avaya ACM - release 4.2.1 and later

l Cisco UCM - release 4.2.1 and later

l ShoreTel - release 4.2.1 and later

l CS 1000 VoIP – release 4.2.2 and later

l Siemens Openscape - release 4.2.2 and later

o De-select theHide Find Related Calls if the above conditions aremet. This allows the Call Tracking ID

column to be selected in Customize Playback View. This also allows the timeline player to auto-

matically find related calls (transfer and conference) and display related calls as tabs in the timeline

player.

l Configure Default Playback View: This button opens a setup window used to select the Playback View

columns to be displayed in the default Playback View, for most deployments:
o System Flags (icon)

o Date

o Start Time

o End Time

o Status (recording)

o Recording Duration

o Hold Duration

o User first (first name)

o User last (last name)
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o Agent ID

o Extension

o CLID

o Dialed Number

o Direction

o Remark1

o Remark2

o Generic1: Only enable if Generic1 field data is configured for Cisco VoIP or Avaya ACM VoIP

o Clicking the Save button will save this configuration and close the window.

l Audit Trail Settings
o Leave the default settings

l Playback URL Settings
o Enable URL Playback – Select this by default.

o Enable URL Encryption – Selecting this hides the UID in the playback URL. This prevents users from

trying to guess other UIDs to playback other calls.

l Engage Password Security
o These settings only apply for user accounts that use Engage authentication. This is not required for

ifWindows Authentication is used to authorize user accounts.

o The default password for new user accounts can be entered.

o Passwords can be configured to expire after so many days.

o Passwords can be set to have a maximum length.
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o Passwords can be set with strong password requirements to require Upper case, Lower case, digits,

or special characters.

l Application Settings
o Inactivity Timeout – This should be left at the default value of 240minutes to help close out user cli-

ent sessions that are no longer active such as when a user leaves for the day.

o Web Content Storage Folder Location – File attachments can be uploaded with Evaluations, Coach-

ing sessions, and E-Learning assignments. These are stored at the location specified. Engage Quality

deployments recommend a dedicated partition for these attachments to help prevent the C:\ drive

from filling up and causing service to fail.

l Quality Options
o Email completed evaluation notification to agent – If the agents are configured as users and have

email accounts, then a notification can sent to the user alerting them that they have an evaluation

to review.

o Email coaching notification to agent – This option allows agents to receive notifications when coach-

ing sessions are created for calls taken by the user.

o Email E-learning notification to agent – This option allows agents to receive notifications when e-

learning sessions are assigned to the user.

l Custom Tab Settings
o This is not typically setup for new installations.

l Speech Analytics Settings
o This feature is enabled via the checkbox for Enable Speech Analytics being selected and Saved.
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6.10.3 Playback Groups Configuration

Refer to the EngageWeb Client Administrator's Guide for detailed information regarding setup tasks.

The Administration » Playback Groups tab groups several users or dialed numbers together for assignment

to user accounts. Modify the group membership as resources are added or removed from the group to sim-

plify user account assignments instead ofmodifying each individual user account. Playback Groups can con-

tain resources from multiple recorders, but cannot be used in a recording schedule.

Access the Administration » Playback Groups tab and create Playback Groups of agents after configuring

the agents. Check that dashboard data populates once calls are taken by agent members of playback groups.

The grid includes the following columns:

l Group Name: A description to help others know the nature of the group.

l Group Type: The type of resources inside the group. The options are by agent, port, mobility user or

dialed numbers.

Groups have the following properties:

l Update user account permissions globally by assigning each user access by Playback Group. (Admin-

istration » Users)

l The Group can also be used to easily search for calls in the Playback Log (Recording » Custom Search).

l Running reports on a specific group can provide both overall and detailed information about howwell the

group compares with other groups. (Reports » NewReport)
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l Sorting is available by selecting the header at the top of each column. The first click will sort ascending, the

second click will sort descending, and the third click will return to the default sort.

l Quick filters are available to refine a search. Click on the Filter Icon in the header of each column to select fil-

ter parameters for that column.

Create a Playback Group

To create a new Playback Group, use the following steps:

1. Access the Administration » Playback Groups tab.

2. Select theNew Group icon from the ribbon bar and the Create Group windowwill appear.
a. Select a Group Type from the drop down box.

l Users: Group of Users. If Inactive Users should be included in the Group, select the Show

Inactive Users checkbox. Any users that have been deactivated will show in the list.

l Dialed Numbers: Group of incoming Dialed Numbers

b. Enter the name of the group in theGroup Name box.

WARNING: A Playback Group Name should not include special characters such as a comma (,) or a

semicolon (;) as a custom searching and reports will fail.

3. Select the appropriate resources from the Available Resources table.
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4. Click the Add or Remove button, or drag/drop them to move selections to the Selected Resources table.

5. Select OKwhen complete and then select OK again from the Create Group Confirmationwindow.

6. The Create Group windowwill remain open to create another group. If complete, Exit this window.

NOTE: An Administrator may create or make changes to a role using any available feature permissions; how-

ever a non-administrator user is restricted in creating new roles with only permissions they are assigned to

by their user account. For example, if a Local Admin user does not have permission for Recorder Ports, they

will not be able to create a role that has the Recorder Ports permission.

6.10.4 Dialed Numbers

Dialed Numbers are not typically configured for new deployments.

They are typically only required for outsourcer customers who have the same agents take inbound calls for

multiple clients if users need to be able to listen to calls for only some clients.

For example, an outsourcer has five (5) clients and some agents take calls for multiple clients. If the end client

requires that they be able to listen to calls, then they must be given a user account that only has access to

their inbound dialed numbers.

6.10.5 User Roles

Refer to the EngageWeb Client Administrator's Guide for more detailed information on User Role setup.
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Configure the User Role s using the Administration » User Roles tab of theWeb Client. This should be done

with the customer IT department if possible, but can be adjusted during or after training. It’s very important

to knowwhich users should be given which roles to minimize any reconfiguration. Start with the built-in roles,

and these roles can be copied if needed.

Key questions to ask include:

l Howmany types of user access are there? There are typically some administrators, supervisors, agents,

and possibly QA. A role is required for each class of user.

l Unrestricted Resources: Which users should be able to playback any call recording? These users should be

given a role with Unrestricted Resources.

l Call Download: Which users should be able to download calls? Most deployments are very sensitive to

allowing users to download .WAV files. Engage supports URL playback which supports emailing a URL of a

call recording, and this recording can only be played back by users that have authenticated access to the

customer network. URL Playback is suggested for most users, and only a few should be granted the Down-

load Calls permission.

l Delete Calls: Which few users should be given permission to delete calls? Note that the audit trail keeps

track of which users are deleting which calls.

l Were Quality licenses purchased?
o Which users should be able to manage forms?

o Which users should be able to manage Evaluations?
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o Enable the Access Evaluations by other Users by default. This lets an evaluator see evaluations cre-

ated by other evaluators. If the agent can logon this MUST be enabled or they will not see any eval-

uations created for them.

o Which users (agents) should only be able to View evaluations? Be sure to enable Access Evaluations

by Other Users for the agent role.

l Administration and Recorder Admin are typically granted to administrators only.

l Which users require access to run reports?

l Which users require access to the dashboards?

Use Administration » User Roles » New Role tab to create and configure User Roles.

6.10.6 User Configuration

Refer to the EngageWeb Client Administrator's Guide for more detailed information on User Configurations

and setup.

User accounts are required for users to logon and use theWeb Client. Users must have user names, IDs, pass-

words and are assigned to roles and groups with specific features. If agents take calls and can also logon to

Engage, this release requires creating the user in the Administration » Users tab and in the Administration »

Agents tab.
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Create a new user:

To create a new user, go to theWeb Client's Administration » Users » New User and get the Create User

Account » Settings tab:

User accounts should be setup after first configuring the resources that can be assigned to user accounts

(Agents, Mobility Users, Dialed Numbers, Playback Groups and/or Recorder Groups). The fields and their data

are described as:

l User Status: Select Active or Inactive.

l Start Date: Selectable drop down field for entering a user's start date and time.

l Last name: Person's LAST name.

l First name: Person's FIRST name.

l Evaluation License: If Engage Quality is included in the deployment, an evaluation license can be assigned

to a user. Evaluation Licenses are required to be assigned to agents only if other non-call related activities

may need to be evaluated.

l User ID: Enter the account the user uses to logon to their workstation.

l Agent ID: This is intended for agents that are able to logon to Engage. Enter the contact center ID for the

agent so the agent can listen to their calls, view their evaluations (if allowed).

l Mobility User ID: Themobility user ID to be used by the user to logon to the Cisco, Microsoft Lync or

Mitel system.

l Extensions: The telephone stations being recorded for this user

l Email1 / Email2 / Email3: Optional and can be used so Engage can send evaluation alerts to evaluated

users, coaching alerts to coached users, and e-Learning alerts when e-Learning assignments aremade to a

user.

l Authentication type: Local Authentication(Engage) orWindows Authentication. Windows Authentication

is preferred for domain networks to remove the need to manage a password within Engage.
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l User Cannot Logon: When selected, this button prevents the user from logging onto the Engage system

until the button is released.

l Password: This is either not required (Windows Authentication) or can be set to the default password

which is setup in Administration » Setup » Engage Password Security.

l Confirm Password: Passwords entered heremust be confirmed.

l Available Roles: Select one role for each user. Engage supports multiple roles, but one role is preferred.

Highlight the role and click on the » symbol to move the role to the Selected Roles column.

l Selected Roles: When a role is selected for a user, it is listed in this column.

l Assign resources : Unless the role includes Unrestricted Resources, or the agent is using My Agent ID, you

must assign resources to the user account. Refer to the User Guide documentation if needed.

l View Permissions: This can be used to check which permissions are granted to the user role(s) assigned to

this user based on the selected role(s).

Assign User to a User Group:

Users may be a member of a team or group. Instead of entering each person in the Users tab and also adding

them to a Playback Group, the tab in the Creating User Account » Member of window allows the admin-

istrator to add the user to a Playback Group as they create a user. The fields and tables of theMember of tab

are:
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l Available Resources: Contains a list of groups or teams to assign users to.
o Group Name: A unique group name.

o Group Type: Signifies the purpose of the group.

l Selected Resources: Groups names that the user has been assigned to.
o Group Name: A unique group name the user has been assigned to.

o Group Type: Signifies the purpose of that group.

Assign Permissions to a User

Use the Permissions to tab to assign individual user accounts access to specific playback groups, or incoming

dialed numbers will selectively designate each user access only certain calls or evaluations. Any call not taken

by one of these resources will not be available for them to search, playback or evaluate. If the user has Unres-

tricted Resources, the Groups, Users and Dialed Number resources tabs will be greyed out.

l Group assignments organize agents or ports into logical groups. Group assignments are used to assign a

specific Playback Group in order for the user to view. Users that have been assigned a group can still

search for individual members of that group.

l User assignments can be used so a user can view calls for a specific set of other users. Typically used when

a group of users is not available or only a partial set of users is needed such as all users that started in the

last 30 days.
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l Dialed Number assignments can be used so a user can view calls to a specific list of dialed numbers.

View a User's Features

View the sum total of permissions assigned to the user by going to the View Features tab. Permissions on

this tab cannot bemodified. To change the permissions for a user, change their assigned roles, or modify the

permissions for an assigned User Role.

For more detailed information on setting up Users, Groups, Permissions and to view a users features, please

refer to theWeb Client Administration Guide.
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7 Installation Completeness Checklist

With the completion of all installation tasks regarding the Engage server, it is time to check the systems vari-

ous components to make sure it is operating correctly.
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7 Engage Installation Completeness Checklist

Customer Name:

Customer Project #:

1 Security Scans on Engage Recorders

Verify restart of TelStrat Voice Recording Service after scans

2 Apply Anti-Virus Real-time Scanning Exclusions to:

C:\Program files (x86)\TelStrat directory

SQL DB and log file directories

TelStrat .WAV cache directories

Proxynetworks screen capture cache directories

3 Customer Worksheets

Verify Agent IDs and Names are correct

VoIP ModuleMapping, show customer how to do this

If Screen Capture present, verify /port/workstation mappings

If On-Demand present, verify workstation mappings

4 Verify VoIP Module Configuration

Check VoIPInfo.log for unnecessary registrations

Ensure Auto-Learning is enabled, when possible.

Check procured virtual phone for every softphone configured

Avaya Red: Check that softphones not over-provisioned
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5 Verify Licenses

Double check the number of licenses for features against order

Make sure .c2v files are submitted, captured and stored

6 Verify Engage is connected

Logon to Web Client and verify Recorder status is Online

7 Verify Engage is Recording

Configure a Recording Schedule

Make test calls on phones within recording schedule

Open Web Client and verify test call was recorded

8 Verify Email Alerts are Received

Use theWeb Client Test Email button, check delivery of email

Verify accounts and emails are configured properly

Suggest the use of SMTP to the customer

9 Verify these TelStrat Engage Services are started

TelStrat Voice Recording Service

.Net TCP Port Sharing

SQL Server (InstanceName)

TelStrat Centralized Error Service

TelStrat Engage Alarm Service

TelStrat Engage Annotation Service

TelStrat Engage Configuration Service
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TelStrat Engage Dashboard Service

TelStrat Engage Download Service

TelStrat EngageMass Archive Service

TelStrat Engage Notification Service

TelStrat Engage Search Service

TelStrat Engage VoIP Configuration Service

TelStrat SIP Server

TelStrat VoIP Engine

Check the version of theDownloadService.exe

10 Verify SQL Dedication (one of the following)

SQLmemory enforces a max limit if Local SQL

SQL is running on a dedicated SQL server (no other Engage apps)

11 Verify Screen Capture, if present

Check available licenses to enable Screen Capture are present

Telephones are associated with named workstations

Workstations have Proxy Pro Host installed

Engage Capture Server running Proxy Pro Gateway Administrator

Engage is programmed with mapping of workstations to phones

12 Verify Live Monitoring, if present

UseWeb Client to check that LiveMonitoring is operational

13 Validate Manual SQL Backups
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Watch customer launch and capturemanual SQL backups

14 Validate Encryption Functionality

Test key import/export process and functionality

15 Voice Recording Configuration Check (CommSrv)

On Voice Recording Database tab, check SQL settings are correct

On Cache tab, check cache partitioning
7.1 Security Scans on Engage Recorders

Security scanning of Engage recorders can cause issues with performance and recordings. The process and its

effects must be understood before running security scans on the Engage Recorder.

Security scanning is used to seek out flaws and security risk opportunities (bugs, misconfigurations, lack of

updates, etc) to exploit on a network or host system. Two common types of Security Scanners are:

l Host Security Scanners: Tests for security risks on a single system starting with an authorized account.

l Network Security Scanners: Looks for security risks from one system from another, connected to the same

network.

In normal operation, the Engage Recording Server is actively recording all stations and/or all trunks, all the

time. This steady steam of voice and call event data is collected, sorted and stored within the server' systems.

When the server is being scanned, there is an increase in processing required and overhead-type data unre-

lated to recordings that is flowing in and out of the server which can cause service issues and adversely affect

recordings.

All companies will have different business requirements regarding security scanning, ranging from those that

must scan everyday to those that are not performing scans at all. Regardless of the requirements, follow this

procedure to stop the recording service during scans to minimize recording issues with Engage.

After running security scans on Engage servers:
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Stop the TelStrat Voice Recording Service:

1. Logon to the Engage server.

2. Navigate to the Services portion of the Server Manager.

3. Scroll down the list and find TelStrat Voice Recording Service and right-click on it.

4. Select Stop and note that the Status should change from Running to an empty field.

5. Run the security scans at this time.

Restart the TelStrat Voice Recording Service:

1. After security scanning is completed, get back on the Services window of the Server Manager.

2. Locate the TelStrat Voice Recording Service entry in the list and right-click on it.

3. Click on Start and note the Status change from an empty field to Running.

4. Logon on to theWeb Client and verify call recording has resumed.

7.2 Verify Anti-Virus Real Time Scanning Exclusions

Real-time protection, on-access scanning, background guard, resident shield, autoprotect, and other syn-

onyms refer to the automatic protection provided by most antivirus, anti-spyware, and other anti-malware

programs.
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This monitors computer systems for suspicious activity such as computer viruses, spyware, adware, and

other malicious objects in 'real-time', in other words while data is loaded into the computer's activememory

such as when inserting a CD, opening an email, or browsing the web, or when a file already on the computer is

opened or executed.

The scanning to set the exclusion from is the real time or on-access scanning, such as scanning a file when it is

created or new to the server.

On demand (scheduled) scanning of files when the system is idle or nearly idle would be fine.

It is recommended to exclude the following from real time scanning:

l C:\Program files (x86)\TelStrat directory

l SQL DB and log file directories

l TelStrat .WAV cache directories

l Proxynetworks screen capture cache directories when using screen capture

7.3 Verify Customer's Input Data vs. Customer's Worksheet Data

Check that the customer's deployment data is correctly inserted into the databases, including:

l Agent IDs and names of agents.

l VoIP modulemappings (show customer how to import/export mappings for backup.

l If using screen capture, verify work station mappings.

l If using on demand feature, verify work station mappings.

7.4 Verify VoIP Module Configuration Meets Requirements

Verify that the VoIP module configuration meets the customer's specifications and needs.

Use the Engage VoIPEngine Config Console to configure the platform that the Engage Recording Service will

integrate with.
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Each vendor's platform has unique elements, settings and configurations to work with Engage properly. Use

the Configmenu command to call up the VoIP Configuration » CTI Option drop-down menu to select the

vendor's platform for the Engage end of the recording connection. This is an example of a BroadSoft

VoIP system deployment.

After configuration, check for any obvious issues that may be preventing recording. Usually, these issues can

be traced back to the initial setups and configurations.

Some examples of out-of-specification issues to look for are:

l Too many softphones for an Avaya red installation have been configured.

l Each customer has procured a virtual phone in the Avaya CM for each soft phone configured. 

l Check VoIPInfo.logmaking sure there are not unnecessary registrations (ex. soft phone registration fail-

ure events).

l Ensure auto learning is enabled, whenever possible.
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7.5 Verify Licenses

Follow these quick steps to verify licenses:

1. Once logged into the Engage JAVA Client, go to Server » License Management

2. The Engage Serial Number will be at the top of the window and a chart will list all the potential licenses that

are available in the Engage system. 

3. Double check the number of licenses for each feature against the Engage features that were purchased. 

4. Make sure final c2v files are submitted, captured and stored.

7.6 Verify Engage Is Connected

Login to the EngageWeb Client to verify that the databases and the recording software are connecting to the

Engage Server.

Go toWeb Client » Administration » Setup » Manage Recorders and make sure all Recorder Statuses are

showing Online.

Need to troubleshoot the issue if a Recorder shows offline.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

192

7.7 Verify Engage is Recording

1. Configure a Recording Schedule that includes the phone to test the recording on. 

2. TelStrat installers can also use a third-party call simulation software application.

3. Make a test call to the phone within the recording schedule.

4. Open theWeb Client and the JAVA Client to see if the call was logged successfully. 

If one or both of the clients did not receive the call successfully, contact the TelStrat Support Team.

7.8 Verify Email Alerts are Received

1. Navigate to Recorder Admin » Email tab and then select the Test Email icon to verify a test email can be

sent.

2. Verify proper service account and emails are configured to customer satisfaction.

3. Suggest the use of the ability for SMTP monitoring to the customer.

7.9 Verify Engage Services are Started

1. From theWindows desktop of the Engage Server, click Start » Settings » Control Panel » Administrative

Tools » Services.

2. Scroll down to TelStrat Voice Recording Server, if the service is not started select Start.

3. Also verify that all these services are Started.
l .Net TCP Port Sharing

l SQL Server (InstanceName)

l TelStrat Centralized Error Service

l TelStrat Engage Alarm Service

l TelStrat Engage Annotation Service

l TelStrat Engage Configuration Service

l TelStrat Engage Dashboard Service

l TelStrat Engage Download Service
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l TelStrat EngageMass Archive Service

l TelStrat Engage Notification Service

l TelStrat Engage Search Service

l TelStrat Engage VoIP Configuration Service

l TelStrat SIP ServerTelStrat VoIP Engine

Check the version of the Download service:

1. Go to the following sub-directory c:\program files (x86)\telstrat\engage\SOA Services\Download.

2. Right-click properties on theDownloadService.exe application file. 

3. Be sure to not accidentally check the properties of theDownloadService.exe.xml configuration file.

4. Trace Logs must be Enabled.
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7.10 Verify SQL Dedication

Verify one of the following:

l SQLMemory enforces a maximum limit if Local SQL.

l SQL is running on a dedicated SQL server with NO other Engage applications.

7.11 Validate Screen Capture Recording

Refer to the SETUP - SCREEN CAPTURE document for details.

7.12 Verify Live Monitoring - if deployed

Livemonitoring is the ability to listen to a conversation while it is in session and being recorded.

Use theWeb Client Online Help system to determine if LiveMonitoring is operating correctly.

LiveMonitoring is fully documented in the onlineWEB CLIENT USERGUIDES.

7.13 Validate Manual SQL Backups

The customer should launch and monitor the completion of a manual backup of the Engage SQL databases to

show that this function operates correctly. Refer to theMAINTENANCE - SQL document for details.

7.14 Validate Encryption Functionality

Test and validate that the Encryption key import/export process and functionality works correctly, if installed.

Refer to the SETUP - ENCRYPTION GUIDE for more details.

7.15 Voice Recording Configuration Check

On the Voice Recording Server Communications Server tool, check the following:

l On the Voice Recording Database tab, check that the SQL Express or SQL settings are correct.

l On the Cache tab, check the Cache partition (one for new installations).
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8.1 Web Client Administration Setup

This section of the installation configures user access for playing back calls and accessing the other WFO fea-

tures of Engage.

8.2 Playback Log

l Recent Calls
o Recent calls fills the page upon user logon. New call recordings will only appear if you select Recent

Calls again.

o Playback a call from IE to verify MP3.

o Delete calls (if user account is enabled). An audit trail record tracks who is deleting which calls.

o Quick filters and clear filter. Quick filters apply only to the subset of calls that are loaded.

o No. (number) of Records defaults to 200. Can be set up to 10,000 but will increase loading time

l Playback Log Grid
o Go over the columns.

o Status: Search for calls with a duration of 5 to 99999 seconds with a recording duration of 0 to 0

seconds. If any calls are found, show the Status icon and how it shows the calculated call duration.

Red icons are present for 0 second records of calls > 5 seconds.
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l Custom Search
o Show a basic time and date search.

o Search by Agent ID.

o Search by extension.

8.3 Active Calls

The Active Calls window can be used to:

l Verify new calls are recording

l Call Status

l Recording Status

l Stream Status

l Video Status

l LiveMonitor Audio

l LiveMonitor Screen Capture (if purchased)
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8.4 Recorder Administration

The training will include a review of the following tabs of theWeb Client:

l Recorder Admin » VoIP
o Add / Manage VoIP devices.

o Select all VoIP devices from the web client and paste into Excel to keep a record of how the system

was initially configured.

l Recorder Admin » Ports
o Port names are recommended for non-agent call recording.

o Verify any screen capture configuration (workstation mapping).

o Verify ODRC settings if ODRC is in use (workstation mapping, delete option, pause option).

o Select all Ports from the web client and paste into Excel to keep a record of how the system was ini-

tially configured.

o Quality licenses should be applied to ports if all phones taking calls can be evaluated.

l Recorder Admin » Recording Groups
o Recording groups are typically only created for deployments that have complex recording schedules

that need to reference a group of ports, agents, dialed numbers, or mobility users within the record-

ing schedule.
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l Recorder Admin » Recording Schedule
o Verify the recording schedule is set to record all calls or rules are setup as the customer requires.

o Recording Schedulemust reference any Gen2 archives.

l Recorder Admin » Archive
o If the customer requires archiving, setup the archives based on customer requirements. Customers

that require different retention policies require an archive per retention duration.

o Does the customer require that calls are deleted from cache after so many days? Verify Server Con-

fig is setup to delete call records and call recordings after so many days.

l Recorder Admin » Service Accounts
o There should be a LiveMonitor, and Web Client service account plus default and one or two system

administrators.

o Add a distribution list or individual email destinations for the customer to monitor system events.

o Add the Engage distribution list SystemAlerts@telstrat.com to receive alerts for new installations or

upgrades unless a specific account email address has been created.

l Recorder Admin » Events
o Test Email and verify the customer admin receives the alert. Verify TelStrat receives the email alert.

o Show the events to the customer including the following:
o Server Ready to Receive Calls: This should only happen when expected.

o VoIP Disconnected / Connected: This should only happen at system start-up. If this occurs

for unknown reasons it indicates a recording fault.

o VoIP Recording Empty: This alert should be setup in Server Config under Misc. tab to only

generate for calls > 10 seconds. Explain that this alert generates if Engage receives a call that

exceeds 10 seconds but did not create a recording. Search for calls that may have generated

this alert and show the Red icon in the Status column in the Playback Log. Very short calls of
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a few seconds may not have time to setup the call recording and generate false error alerts.

These are filtered out with the Server Config setting.

8.5 Administration

The training will include a review of the following administration tabs of theWeb Client:

Admin » Users

l Show the administrator how to Add / Manage User Accounts.

l If agents will logon to retrieve their calls, setMy Agent ID for any agents.

Admin » User Roles

Go over the User Role Permissions for roles that are in use.

Discuss with the customer which roles should have the following permissions:

l Unrestricted Resources –Which users should be able to playback any call recording? If there aremul-

tiple QA or top level supervisors, then be sure to grant Unrestricted Resources permission to roles

assigned to those users.

l Download Calls – Disable except for a few users
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l Playback URL – Suggest enabling this for most users so they can email URL links to calls which are

secure. These URLs can only be played back by recipients that have access to the customers network.

l Delete Calls –What users if any should have this permission.

Admin » Agents

l Explain that agent names populate based on call records that have an Agent ID.

l Agent names can be added after the call is recorded and they will then appear for next user logon in the

Playback Log

l Agent ID recycling is not supported in this release. The currently provisioned agent namewill appear in the

Playback Log

l Set Agent ID to appear in all call records in server config under Misc. tab.

l Evaluation licenses should be applied to agents unless there are too many agents due to multiple shifts

(use Port licenses instead).

Admin » Dialed Numbers

This is typically only required for outsourced contact centers that share agents across multiple projects or cus-

tomers. This can be used so a supervisor might only have rights to playback calls for a pre-defined list of dialed

numbers (incoming numbers) for a particular project or customer.

Admin » Playback Groups

l Playback Groups can contain agents, dialed numbers, mobility users from multiple call recorders. Record-

ing Groups are stored on the recorder and cannot contain resources from multiple recorders. Recording

Groups can be referenced by a recording schedule or for assignment to a user account, but Playback

Groups can only be used for assignments to a user account.

l Agents should be placed into Playback Groups and then assigned to any supervisors that are not granted

the Unrestricted Resources permission.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

201

l Agent groups are needed for the dashboard to display data by group and to compare agents within a

group.

l Consider creating an “All Agents” group especially if no business users were granted Unrestricted

Resources permission.

Audit Trail

l Show how the audit trail tracks who is playing back, live monitoring, or deleting calls. The call is tracked as

well.

Setup Tab consists of these areas:

Manage Recorders

l View the recorder connection. Show how the web client connects to the recorder using a service account,

and the recorder database location is listed to help find it for SQL backups

Database

l This tab shows the location of the application (web) database

Email Settings

l Review the SMPT server information located here and verify the same information is configured in Server

Config under Email on the recording server.

l Configuring this via the web client will also push the same configuration to Server Config Email tab.

l The web setup SMTP settings are used for emailing calls, evaluations, or reports.

l Server Config email setting is used for emailing system events.

Display Settings
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l Hide ACD Agents: Unchecked by default. Select if this is a non-agent deployment.

l HideMobility Users: Un-check only for Cisco UCM deployments if the customer uses extension mobility.

Logoff and logon to the web client to add the Admin >Mobility Users tab

l Hide Find Related Calls : Un-check for Cisco UCM, Avaya ACM, CS 1000, and ShoreTel. Leave set for all oth-

ers. If un-checking, then logoff and logon again so Tracking ID is available as an available column.

l Configure Default Playback View and explain that each role can be set as well.

l Un-select port names or move to the right past agent name

l Typical recommended setup is for a contact center:
o Date

o Start Time

o End Time

o Recording Duration

o Direction

o CLID

o Dialed Number

o Direction

o Agent First

o Agent Last

o Agent ID

o Remark1

o Remark2

o Recording Status

l Remove any unused columns such as encryption, screen capture, or archive status.
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l Users will not be updated unless they select Restore Default View from Playback Log settings.

Playback URL Settings

l Verify Enable URL Playback is enabled

Local Password Security

l Configure with the customer if users will be using local authentication

Application Settings

l Review the inactivity timer & web content storage folder

8.6 SQL Backups

Discuss SQL backups with the administrator.

l Will the customer be setting up a periodic SQL backup?

l Key databases to backup include Config, SRecordingCache, and Engage.

8.7 Support

l Software Updates
o Service affecting issues are typically resolved in a patch upon request.

o Periodic maintenance releases are released every 2-3months as needed to roll-up patches into a

single release.

l Parature Ticket Process
o Administrator training by the trainer will cover the Parature ticket process.

o Until the administrator training is provided, any issues found aremanaged through the installation

ticket or new tickets are created by the software provider.
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9 Monitoring

Once the installation is complete, themonitoring phase begins. The installation team will proactively monitor

the system for five (5) business days. During this time, the system events will bemonitored based on email

alerts as well as periodic event retrieval.

If unattended access is provided, the system will be checked for call recording failures by running a search for

calls longer than 5 seconds that have a 0 second recording duration.

Tasks performed during themonitoring phase include:

Proactive Monitoring and Cleanupwith exit criteria:

l Five (5) days clean of unexpected Recorder Admin » Events.

l No unexplained zero (0) second recordings for call >10 seconds in duration.

Event Monitoring:

l Create a user account with the installer or auditor's name.

l Installer will add SYSTEMALERTS@TELSTRAT.COM to receive events alerts.

l Run test email and verify we receive the alert.

l Monitor Recorder Admin > Events daily and make sure we are receiving email alerts for all events.

l Acknowledge alarms and put notes in the alarm about root cause.

l Verify that Mass Archive delivery path is setup via Recorder Admin » Archive.

Proactive Call Recording Warning Search for five (5) days.

l Run customer search for call duration five (5) to 99999 seconds with recording duration zero (0) to zero

(0) seconds for today and yesterday or since new installation or the last time checked.

l Resolve all RED status icons.

Mass Archive: On successive days after initial Engage startup:
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l Double check the calls are being archived via MAG 2.

l Access the web client and go to Recorder Admin » Archive » View

l Check that the storage location status is OK.

l Verify there are no issues with a red ! .

dferris

Upon completion of themonitoring phase of the installation, the install team should remove their email

addresses from the customer's system. The systemalerts@TelStrat.com email address will need to be

removed from the customer's system, as well.
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10 Troubleshooting

During the effort to install and configure an Engage Voice Recorder to a vendor's platform, there will be issues

that arise. This section contains common troubleshooting issues and recommended fix actions to keep the

installation moving.

10.1 Web Server (IIS)

If a user attempts to access the web server and the logon screen does not appear, additional details may be

available by logging onto the web server and accessing the web URL directly from the web server itself.

More details are generally provided when accessing the web client from the web server.

This section details common Web Server - Application Server problems and how to troubleshoot them.

10.2 Setting Verbose Web Logs

To get more detail in the log commentary (also known as verbose web logs), change this field value in the

web.config file of the web site.

Enable verbose web logs by modifying theweb.config file level value setting from ERROR to ALL. This file is loc-

ated in the web site virtual directory.

Web.config is themain settings and configuration file for an ASP.NET web application. The file is a XML doc-

ument that defines configuration information regarding the web application. This file stores the information

about how the web application will act. The web.config file contains information that controls module loading,

security configuration, session state configuration, and application language and compilation settings. Web.-

config files can also contain application specific items such as logging traits.

Warning: Be very careful to note what is changed in this file. Make a copy of this file for reference, if needed,

by using the Save web.config as... file menu command.
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1. On the web server, navigate to this location: C:\inetpub\wwwroot\Engage, scroll down to the bottom of

the list and look for theweb (also known as web.config) XML Configuration file.

2. Double-click on it to open the configuration file.

3. Scroll down the file and locate the XML file comment line: <!--Begin:: Log Settings using Log4Net dll -->



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

208

4. Locate the line <logger name="File" />

5. Locate the line <level value ="ERROR" /> , highlight "ERROR" and change the value to "ALL" .

6. Under the File menu, click theSave web.config command to save the change.
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7. Exit the program.

10.3 Web Server Upgrade Failure - Rolling Back Action

Symptom: Web client instance fails to install – Rolling Back Action

Cause: An issue has been observed during someweb server upgrades. During the installation of the web client

instance, the software indicates “Rolling Back Action” and then the installation fails. The following work

around can be applied:

NOTE: This was discovered on a Server 2012 R2machine so it is possible that the file could be in a different loc-

ation for other OS.

Solution: Or theWORKAROUND:
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The solution is to manipulate some file content as follows:

1. Locate the applicationhost.config file. This should be found in the folder C:\win-

dows\system32\inetsrv\config folder.

2. Edit the applicationhost.config file. Find the section for Engage (the virtual directory that you are not able to install) and carefully
remove it from the file. It should look like this:

<location path="Default Web Site/Engage">

<system.webServer>

<handlers accessPolicy="Read, Script" />

<security>

<authentication>

<windowsAuthentication enabled="false" />

<anonymousAuthentication enabled="true" />

.

.

.

<mimeMap fileExtension=".xbap" mimeType="application/x-ms-xbap" />

</staticContent>

</system.webServer>

</location>
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3. Use the Filemenu to Save the changed file.

4. Restart the IIS by navigating to the IIS Manager » servername » Manage Website and clicking on

Restart.

5. Install theWeb Client software again using "Engage" as the virtual directory.
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10 HTTP Error 500 Web Client Timeout

Symptom:When the Engage web server encounters an unexpected condition that prevents it from fulfilling

the request by the web client for access to the requested URL, the web client can time-out and/or produce

HTTP Error 500s.

Possible Cause: HTTP Error 500s are 'catch-all' errors generated by the web server indicating something has

gone wrong, but the server can not bemore specific about the error condition in its response to the client.

Solution: The EngageWeb Client web.config file will need a change to be implemented on the "HostName"

default value.

To make the change, do the following steps:

1. On the server, open theNotepad program as an administrator.

2. On the drop-down menu in the lower right-hand corner, change Text Documents (.txt) to All Files .

3. Open theweb.config file located on the web server by going to c:\inetpub\wwwroot\<database>\web,

which is the XML configuration file for the web client.

4. Click on the Editmenu command to get the pop-up menu, click Find to get the Findwindow and enter

HostName to locate the specific line of code to change in the add key= list.

5. In theweb.config XML file, the code string to work with is <add key="HostName" value="" />.

6. Highlight the two quotemarks ("") in the string (ex. <add key="HostName" value="" />).
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7. Enter localhost in between the quotemarks (ex. <add key="HostName" value="localhost" />)

8. On the Notepad's Filemenu, click Save to save this change in the file.

9. Close the file.

10. From the Start menu, open a Command Prompt window and enter the command IIRESET. This will restart

the IIS server so that the new value will be used.

This specific change will to be a default condition in future releases of Engage.

10.4 HTTP Error 503 The service is unavailable

The 503 Service Unavailable error is an HTTP status code that means the web site's server is simply not avail-

able right now.

Symptom: This error code has been seen when the Engage Application Pool under IIS is not started.
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Solution:

1. Logon to the web server and open the IIS Manager tool.

2. Expand (+) the server connections, click on Application Pools and look for EngageAppPool3.7 and its

status.

3. If it is Stopped, right-click on the pool line entry to get the pop-up menu and click Start.

4. Close the IIS Services Manager.
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10.5 Troubleshoot (405) Method Not Allowed Issue

(405) Method Not Allowed may be resolved by adding HTTP Activation to the Application Server role on Win-

dows Server 2012 underWindows Process Activation Service Support.

Refer to adding the Application Server role for Server 2012 procedure.

Verify all required application role selections aremade as shown.

10.6 Web Server upgrade fails if Application Server Role not Enabled

Symptom: During the installation process, the setup program execution encounters a problem and the fol-

lowing messagemay be displayed:
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Possible Cause: Receiving this problem message could indicate that the Application Server role was not

enabled during theWeb Server installation process.

Solution:

1. Click OKwhich will stop the installation process.

2. Go to the Server Manager tool of theWeb Server.

3. Check that the status of the Application Server role is Enabled on the web server.

4. If not, Enable the Application Server role by using the steps in theWeb Server section of this guide.

This has been known to resolve this issue. Once enabled, continue with the installation

10.7 Troubleshoot "Not connected to Database" Errors

If the statement "Not connected to Database" appears in theWeb Client's Logon Dialog box, this indicates the

account being used may not be properly configured. Perform these steps to troubleshoot the issue:
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1. Confirm that the <domain\servername$> is currently attempting to access the SQL Instance. On the

recorder server:
a. Go to Start » SQL xxxx Server Management Studio and login.

b. On theObject Explorerwindow, scroll down the list toManagement » SQL Server Logs » Current -

mm/dd/yyyy.

c. Use the Search button to get the Searchwindow and search the Current log for domain\server-

name$ for logs with the $ symbol (ex. tsi\techpub2012$).

d. When finished, close the log file and Exit out of the SQL Server xxxxManagement Studio.

2. When the <domain\servername$> attempts are confirmed by the SQL log search, update the web server's

Local Administration Group with theWindows Account attempting to authenticate with SQL.
a. Open the Server Manager » Computer Management » Local Users and Groups » Groups.

b. ADD theWindows account that is to be used by the web client to the Administrators Group.
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3. Check the IIS Manager configuration.
a. Go to IIS Manager » <servername> » Application Pools.

b. Highlight EngageAppPoolx.x and right-click to get the pop-up menu and select Advanced Settings.
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c. Scroll down the list to Process Model and note the Identity field. The field may be updated to

reflect theWindows Account just added into the Local Admin Group or it may indicate Network Ser-

vice. Read the definition at the bottom of the window for more details about Identity.

4. Add theWindows Account into the SQL Instance and assign the necessary Server Roles and User Map-

pings. Use the CREATE SQL ACCOUNT FOR ENGAGE FORWINDOWS AUTHENTICATION.HTM topic in this guide for

details.
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5. Reload theWeb Client and confirm that the "Not connected to Database" warning is gone.

10.8 Recorder Version is Blank in the Manage Recorders window
Symptom:

When adding the connection to the recorder, the displayed recorder version is blank.

Cause:

This indicates an issue with the Engage SDK, which is used by the web server to connect to the recorder.
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Solution:

This condition can be resolved by registering these two interface files on the web server:

l CommSrvApiSrv.exe

l CommSrvApi.dll

1. Logon to the server. From the Startmenu, go to This PC and navigate to c:\inet-

pub\wwwroot\Engage\bin. The files are located in the virtual directory \bin folder.

2. Manually search for and delete all copies of these files except the ones located at the web server folder.

You can then register the files as follows:

a. Open a Command Prompt and select Run as an administrator.

b.

c. At the Administrator Command prompt:
o Enter cd c:\ to change the directory to the c: drive.

o Enter cd inetpub\wwwroot\engage\bin

o Enter CommSrvApiSrv.exe /regserver

o Enter regsvr32 commsrvapi.dll
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d. The response should be:

If you receive the following error message, it may be due to not running the command prompt as an admin-

istrator. Close the command prompt then repeat the above steps.
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10 HTTP Error 500 Web Client Timeout

Symptom:When the Engage web server encounters an unexpected condition that prevents it from fulfilling

the request by the web client for access to the requested URL, the web client can time-out and/or produce

HTTP Error 500s.

Possible Cause: HTTP Error 500s are 'catch-all' errors generated by the web server indicating something has

gone wrong, but the server can not bemore specific about the error condition in its response to the client.

Solution: The EngageWeb Client web.config file will need a change to be implemented on the "HostName"

default value.

To make the change, do the following steps:

1. On the server, open theNotepad program as an administrator.

2. On the drop-down menu in the lower right-hand corner, change Text Documents (.txt) to All Files .

3. Open theweb.config file located on the web server by going to c:\inetpub\wwwroot\<database>\web,

which is the XML configuration file for the web client.

4. Click on the Editmenu command to get the pop-up menu, click Find to get the Findwindow and enter

HostName to locate the specific line of code to change in the add key= list.

5. In theweb.config XML file, the code string to work with is <add key="HostName" value="" />.

6. Highlight the two quotemarks ("") in the string (ex. <add key="HostName" value="" />).
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7. Enter localhost in between the quotemarks (ex. <add key="HostName" value="localhost" />)

8. On the Notepad's Filemenu, click Save to save this change in the file.

9. Close the file.

10. From the Start menu, open a Command Prompt window and enter the command IIRESET. This will restart

the IIS server so that the new value will be used.

This specific change will to be a default condition in future releases of Engage.

10.9 Troubleshoot "Engage Record Server Not Found" errors

The Engage JAVA client is an essential tool for configuring the Engage Voice Recorder. Theremay be times

when an error occurs that requires troubleshooting to isolate an issue that affects the JAVA client. The

troubleshooting occurs on the Engage server where an error messagemay appear:
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If the Engage JAVA client cannot logon to the Engage Record server, open the TmpInfo.log file located at

C:\Program Files (x86)\TelStrat\Engage\Logs to look at what step has failed.  The log file often times can be

used to pinpoint the failure.

There are four tmpinfo.logmessages to look for and respond to. They are:

l TmpInfo.log message showing InitLicenses() Failed

l TmpInfo.log message showing SQL Connection Error 80043c9d

l TmpInfo.log message showing SQL Connection Error 80040000

l TmpInfo.log message showing Database ‘Config’ could NOT be created

There is one Licensing Dongle issue that can cause the Engage Server Not Found error.
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10.9.1 TmpInfo.log shows InitLicenses() Failed

Symptom: The TmpInfo.log shows the following error can occur if the installer did not configure Engage to use

the software licenses or if the license key is invalid.

ILicenseManager::InitLicenses() Failed with error code 1! 12/06/14 14:08:18

InitLicenseManager Failed - Will Retry in 30 second. 12/06/14 14:08:18

Cause: Engagemay not be configured to use software licenses, the software license key may be invalid, or the

Sentinel service is not running properly and CommSrv is unable to reach it.

Possible Solutions:

Check the License Tab in CommSrv

1. Open the Server Configuration (CommSrv) tool and go to Licenses tab. Verify Use Soft License is selec-

ted.

Check Services for Running Status

1. Open theServices tool on the recording server and verify the Sentinel LDK License Manager service is run-

ning.
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2. Restart the Sentinel LDK License Manager by right-clicking on the service name to get the pop-up menu

and then click Stop then Start.

Check the Sentinel LDK Installation

1. If this is a new installation and it has never been started, try re-running the haspdinst.exe file. Use the

default settings. From Start » Run » cmd to get the cmd.exewindow.

2. Using the Change Directory command (dc), navigate through the directories to the Engage directory.

3. Enter haspdinst.exe in the cmd box and view the program window. Various switches are described. Use

the -i switch to install the Sentinel program (ex. haspdinst -i).
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4. Enter haspdinst -i in the cmd box. The program will take a moment to install and display the windowwhen

complete.

5. If the voice recording server was not or has not been restarted after initial installation, restart it now.

10.9.2 TmpInfo.log shows SQL Connection Error 80043c9d

Symptom: The TmpInfo.log file shows the following error:

SQL Connection Error 80043c9d

Re-Attempt #21 to connect to SQL Server PRODMGMT43\ENCACHEX

SQL DMO 'Connect' Error:<BEGIN>

[Microsoft][ODBC SQL Server Driver][SQL Server]Cannot execute as the database principal because the
principal "guest" does not exist, this type of principal cannot be impersonated, or you do not have per-
mission.

Cause: This is typically caused when Engage is not configured with the correct SQL login and password inform-

ation.
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Solution: Launch the Server Configuration program, go to the Voice Recorder Database tab and enter the

SQL login and password information. Restart the TelStrat Voice Recording service.

10.9.3 TmpInfo.log shows SQL Connection Error 80040000

Symptom: TmpInfo.log file shows the following error:

SQL Connection Error 80040000

Re-Attempt #5 to connect to SQL Server SqlServer\encachex

SQL DMO 'Connect' Error:<BEGIN>

SQL Server does not exist or access denied.

ConnectionOpen (Connect()).

Possible Causes:

Cause: Firewall Settings are blocking the SQL connection.

Solution: Confirm with the customer that the firewall settings appropriate for the deployment and voice plat-

form have been made.

Cause: SQL is not setup to allow remote access.

Solution: Open the SQL Server Configuration Manager and check if TCP/IP is set to Disabled which is the

default setting. Change it to Enabled . Restart the SQL Server (server name) service. The TCP/IP protocol

must be enabled in the SQL Server.
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10.9.4 TmpInfo.log shows Database ‘Config’ could NOT be created

Symptom: TmpInfo.log file shows the following error:

ERROR: Database 'Config' could NOT be created successfully - 0x80041432

Cannot create file 'c:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS\MSSQL\DATA\Con-
fig_Data.mdf' because it already exists. Change the file path or the file name, and retry the operation.

CREATE DATABASE failed. Some file names listed could not be created. Check related errors.

Cause: This can occur if the Config database is not attached in SQL but the Config.mdf file is present.

Solution: Attach the Config.mdf file if the config database should already be connected or delete the file and

Engage will create a blank database with no configuration (if that is the intent).

10.10 Engage Server Not Found - Dongle Release Mismatch

Another reason to receive the Engage Server Not Found error is a mismatch between the license dongle and

the Engage applciation.

Symptom:

Server Error Warning

Application Started at 06/25/2015 14:36:04 06/25/15 14:36:04

Server Version 4.1.1.1

CServiceModule::InitializeDataMgr()::new CDataMgr()... 06/25/15 14:36:04

InitLicenseManager:LIC_PROVIDER_SAFENET 06/25/15 14:36:04

License Server inititialized successfully. 06/25/15 14:36:05

Detected VMWare: ESX 06/25/15 14:36:05



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

231

INFO: CommSrv Server is running in Virtual Machine Env.

Dongle is programmed for a maximum version of 3.6, App version is 4.1. The Server will now exit. 06/25/15 14:36:05

Cause:

License dongles are programmed to run on purchased releases of Engage applications. If the Engage applic-

ation release does not match the dongle, the server will not connect.

Solution:

Contact TelStrat Customer Support and request an updated license key that authorizes the newer software

release.

10.11 Troubleshoot "Download Service Not Found" Error

If call playback is not working and/or theDownload Service Not Found error window is delivered on the

screen, there are two areas to check.

Check the TelStrat Engage Download Service state

Engage Services requires setting the TelStrat Engage Download Service to Automatic Mode and then starting

the service. The installation program automatically makes this configuration change as part of the installation.

The TelStrat Engage Download Service is essential for downloading and playing calls. If the service is not run-

ning, no calls can be played.

Verify that the TelStrat Engage Download Service is Running on the Engage Voice Recorder. The installation

program automatically makes this configuration change as part of the installation. To do this:

1. Go to the Engage Server's Services tool.

2. Scroll down and find TelStrat Engage Download Service and verify that Running is in the Status column.

3. If the Status area is empty, right-click on the TelStrat Engage Download Service name and use the drop-

down menu and click onStart. This should start the service and Running should appear in the Status

column.
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Check the Net.TCP Port Sharing Service state:

Engage Services requires setting theNet.Tcp Port Sharing Service to Automatic Mode and then starting the

service. The installation program automatically makes this configuration change as part of the installation.

TheNet.Tcp Port Sharing Service provides the ability to share TCP ports over the net.tcp network.

If this service, Net.Tcp Port Sharing Service, is not Running, then theWeb Client cannot connect to the

TelStrat Engage Download Service and the TelStrat Engage Annotation Service (in Engage Release 4.0.5 or

newer) and theWeb Client user interface will be unusable.

To check the status of these services:

1. Go to the Services tool of the Engage Voice Recorder.

2. Scroll down the list of services and find Net.Tcp Port Sharing Service and verify that Running is in the

Status column.

3. If the Status area is empty, right-click on theNet.Tcp Port Sharing Service name and use the dropdown

menu and click onStart. This should start the service and Running should appear in the Status column.

4. Be sure to check that the two associated services (TelStrat Engage Download Service and TelStrat Engage

Annotation Service) are in the Running state in the Status column. If not, right-click on each an click Start.
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10.12 Troubleshoot License Management

The Engage JAVA client is used to reveal the system's software licenses. The information on a specific server is

found by using themenu and navigating to the Server » License Managementwindow.

When licenses are not installed or are invalid (out of date, wrong serial number, etc), the Engage system will

not function correctly.

Each system comes with a set of various product-related licenses, depending on what was purchased. These

licenses are:

l Recording Seats:

l Evaluation Seats:

l Screen Capture Seats:
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l Voice Analytics Seats:

l Centralized Management:

l Clustering:

l File Encryption:

l Licensed Version:

l Maintenance:

Symptom: An example of a failure to apply a software license generates repeated alert messages (in the Temp-

info.log file) such as:

ILicenseManager::InitLicenses() Failed with error code 1! 05/31/15 12:30:38

InitLicenseManager Failed - Will Retry in 30 second. 05/31/15 12:30:38

ILicenseManager::InitLicenses() Failed with error code 1! 05/31/15 12:31:12

InitLicenseManager Failed -Will Retry in 30 second. 05/31/15 12:31:12

ILicenseManager::InitLicenses() Failed with error code 1! 05/31/15 12:31:46

InitLicenseManager Failed -Will Retry in 30 second. 05/31/15 12:31:46

ILicenseManager::InitLicenses() Failed with error code 1! 05/31/15 12:32:20

InitLicenseManager Failed -Will Retry in 30 second. 05/31/15 12:32:20

Cause: Engagemay not be configured to use the software licenses or the software license key may be invalid.

Solution: Verify that the correct and valid software licenses have been installed on the Engage Voice Recorder.

10.13 Troubleshoot Playback Calls

This section provides common troubleshooting of Playback Calls issues.

10.13.1 Audio Playback Fails in IE11, IE10 and IE9

Playback fails in IE11, IE10, IE9. The Timeline displays with 0 (zero) second duration.
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If theMP3encoder.dll file is missing on the Engage Record server, the timeline player may show a valid

timeline, but the call duration shows 0 (zero) seconds.

IE11, IE10, and IE9 support playback of .MP3 files only using the timeline player. Engage requires anMP3en-

coder.dll file that is included with theMicrosoft Visual C++ 2010 Redistributable Package.

If playback within IE9-IE11 fails and the .MP3 download fails, then install theMicrosoft Visual C++ 2010 Redis-

tributable package found in theWindows Pre-reqs folder of the Engage prerequisite software folder.

Refer to the Engage Server Pre-Requisite Tasks section of this Server Installation Guide for instructions.

10.14 Timeline Graphic Fails in IE11, IE10 and IE9

Symptom: Graphic is displayed, but audio will not play and timeline displays 0 (zero) second duration.

Troubleshooting: Check if theDesktop Experience feature is enabled on the server. This is required to support

the timeline player graphic for IE9-IE11.

Solution: Install theDesktop Experience feature for Windows Server 2008 R2 or 2012.
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10 Playback Fails for Administrator

Sometimes, a workstation's current User Account Controls (UAC) settings prevent the Internet Explorer from

installing the Active-X player. To repair this:

1. Click the Start button, go to and right-click on Internet Explorer.

2. From the pop-up menu, click on Run IE as the Administrator. IE will launch.

3. Logon to the EngageWeb Client to load the Active-X player.

Once IE is run as an Administrator, playback is available in BOTH administrative and standard user modes.

10.15 Windows Audio Service Crashes Server Config
Symptom:

When using the Server Configuration (CommSrv) program of the Engage server on Windows Server 2012 R2,

an error window (The extended attributes are inconsistent) can pop up and display.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

237

Cause:

This error indicates that theWindows Audio service is not Running on the server. The error can occur after try-

ing to launch CommSrv. When changes are being made to a computer by a program via a user, the User

Account Control (UAC) process normally provides a audible BEEP and in some cases, an information/request

window. When the error occurs, theWindows Audio service is not running, which prevents the playing of the

audible sound file, which causes the error.

Solution:

There are two ways to start theWindows Audio service:

Use the Desktop Personalization window:

1. Logon to the server.

2. Right-click on the desktop area to get the pop-up menu and click on Personalize. Click on the Sounds

option.

3. The error windowAudio Service Not Runningwill appear.

4. Click Yes and the Sound themewindowwill appear. Click OK to select theWindows Default sound theme.
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Use the Services Tool:

TheWindows Audio service can also be started using the Services tool.

1. From the Startmenu, launch the Services tool.

2. Scroll down the list of services and right-click on theWindows Audio service name to get the pop-up menu.

3. Click on Start to start the service.

10.16 Event Monitor not Functioning

The Engage Event Monitor is responsible for delivery of system event messages and content. This important

information can be sent to administrators or users using:

l e-mail addresses.

l SMTP messaging.

l theWeb Client’s Events button.



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

239

The Engage Event Monitor application expects to use installed Microsoft Visual C++ 2008 and 2010 software

elements. The complete implementation of the Engage Recording Server requires the following up-to-date

Visual C++ components be installed on the server:

l 2008vcredist_x64

l 2008vcredist_x86

l 2020vcredist_x64

l 2010vcredist_x86

If system events are failing to be generated (not being delivered to e-mail addresses, showing up in

SMTP messaging or there are no events when using theWeb Client's Events button), check for proper install-

ation and most recent versions of the C++ software:

1. Go to the server's Control Panel.

2. Locate the software components (ex. with names such as Microsoft Visual C++ 2008 Redistributable -

x64...)

3. If the software is missing, reinstall it.

10.17 TALC Card Traces and Commands

Access the TALC through Telnet client.

Go to Edit and hit Start Loggin



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

240

Give the file a name

In Debuf, type pf 2 port

Leave the session open so it logs all the calls on the port.

When the TALC card is ready to communicate, it displays:

TALC_RDY>

dc 0,s: Dumps the configuration of the card.

displog shows the events on the board (reset, login, connection to IDVR).

Description of dump elements:

Ex. IPCFG 192.168.143.134, 255.255.255.0, 192.168.143.254, 0.0.0.0, 255.255.255.0, D

IP Address: 192.168.143.134

IP Network Mask: 255.255.255.0

IP Gateway: 192.168.143.254

Management IP Address: 0.0.0.0

Management IP Network Mask: 255.255.255.0

Ethernet Full Duplex [E-Enable D-Disable]: D

Ex. SYSCFG 1,IDVR Beta Card 1

Board ID: 1
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Node Name: IDVR Beta Card 1

Ex. ACCFG E, 1, 04:00, 16, 0, 4728

Configuration name: accfg

DN Discovery[E/D]: E

DN Discovery Frequency [1-Per Day 2-Per Week 3-Per Month]: 1

DN Discovery Time [hh:mm]: 04:00

Extension to Dial - Port Number: 16

Extension to Dial - Feature Key: 0

Extension to Dial - DN: 4728

Ex. PORTCFG 0, E, 1, D, D, N, D ,D

Port Number: 0

IDVR Status [E/D]: E

IDVR CompressionRate[0-G711 1-G723.1]: 1

TAPI Support [E/D]: D

2250Port[E/D]: D

Configure Agent ID ?[Y/N]: N

Beep Tone [E/D]: D

Virtual Phone Recording [E/D]: D
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Ex. FKEYCFG 1,13 EREC ,14 ECS ,9 RDIS ,NC

Device Number: 1

Feature 1

KeyNo Feature Data: 13 EREC (record)

Feature 2

Key No Feature Data: 14 ECS (Conversation save)

Feature 3

Key No Feature Data: 9 RDIS (Delete Recording)

Feature 4

Key No Feature Data: NC

Config commands

Attribute rc : Type rc before any of the following config commands and the system will print the current config

for that command.

Dm i

ip: set the IP address of Card

syscfg: set the unit ID, and Node Name

idvrcfg : enable, and set the IP address of server

accfg: set DNDiscovery

portcfg: configure a port
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fkeycfg: configure key for port

sympdispcfg: symposium configuration

sc y: save configuration

sr 1,y : reset board

us: upload software

uc: upload configuration

DEBUG Commands and Suggestions

wh displays version number of the card and how long the card has been up

pf 4 (port 0 - 15) captures information sent between card & Phone

pf 4 (port 32 - 47) captures information sent between card & PBX

cp 5 (port 0 – 15) snapshot of the phone

cp 085 <port> To see the DNDiscovery of the particular port

db 13 5 displays cross connect information

db 2 153 Call start information

db 2 154 detailed call start information

db 2 8 See DND discover run

db 2 184 Agent login

db 8 y IDVR StateMachine

db 2 026 Call StateMachine
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cp 021 <port> To see the Call Bits for the port

cp 022 <port> To see the RSM (Recorder StateMachine) for the port – use it for recording problem

ES 1Network states

Dcb DSP information

NVD

CPP MADN enable disable

TMS (set in seconds) Time stamp (default 60 for 1minute)

Sdp 13 3 port Beep tone

Sdp 8 3 port ?

sdp: Set Debug Print Level: Type (max=18), Level (max=3), Channel(max=31)

0 : Icon Control

1 : Connect ID

2 : Privacy Override

3 : Line Preference Key (LPK)

4 : Redundant_Indicator

5 : CP Virtual Device

6 : CP Call Handler

7 : CP Call StateMachine

8 : CP RSM Manager



ag160414 Copyright © 2016, TelStrat International, Ltd.
All rights reserved.

245

9 : CP Recorder StateMachine

10 : IDVR Keys

11 : CPND StateMachine

12 : Softphone Hotline StateMachine

13: Recording Beep Tone

14 : ACD Call Force Tone

15 : Fast Path

16 : KBA Phase II From PBX

17 : Overlay

18 : DC IDVR Call Manager

During a debug session, always do the following:

l When doing traces, annotate what the user is doing. Use special characters (ex. !, @, #, $, % etc.) to mark

the comments.

In debug window:

l wh: Get the version, how long the card has been up.

Before closing the debug window and while in theMMI window:

l dc: Get the config

l dlog: Get the display log

When a customer reports a problem, while communicating with them, always get:
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l Card’s config

l TNB of the whole slot

l Symptoms of failure

l Exact date/time of failure

l Frequency of failures

l Finally, get a VERY detailed description describing exactly (as close as possible) what the user is doing
(ex. keys being pressed, how many times, lamp status whether on, off or blinking, and any other
symptoms) to generate the issue.
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